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SOLIDWORKS® 2020 Reference Guide Design Intent, Sketching and Sketch Entities

CHAPTER 4: DESIGN INTENT,
SKETCHING AND SKETCH
ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the
available Sketch Entities in SOLIDWORKS. On the completion of this chapter, you will
be able to:

e Define and incorporate Design Intent in a:
e Sketch, Feature, Part, Assembly, and Drawing document.
e Utilize the available SOLIDWORKS Design Intent tools:

e Comments, Design Binder, ConfigurationManager, Dimensions, Equations,
Design Tables, and Features.

o Identify the correct Reference planes:
e 2D and 3D Sketching.
e Insert sketch Reference planes.
e Comprehend the Parent/Child relationship.
e Recognize and address Sketch states:

e Fully Defined, Over Defined, Under Defined, No Solution Found, and Invalid
Solution Found.

e Identify and utilize the following Sketch Entities tools:

e Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle,
3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot,
3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter
Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve,
Point, Centerline, Text, Plane, Route line, and Belt/Chain.

e C(lassify and utilize the following Block tools:

e Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block,
Explode Block, and Belt/Chain.
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e Recognize and utilize the following Spline tools:

e Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify
Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum
Radius, and Show Curvature Combs.

e Reuse an existing 2D Sketch.

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the
intellectual arrangements of features and dimensions of a design. Design intent governs
the relationship between sketches in a feature, features in a part and parts in an assembly.

The SOLIDWORKS definition of design intent is the process in which the model is
developed to accept future modifications. Models behave differently when design
changes occur.

Design for change. Utilize geometry for symmetry, reuse common features, and reuse
common parts. Build change into the following areas that you create: sketch, feature,
part, assembly and drawing.

When editing or repairing geometric relations, it is considered best practice to edit the
relation vs. deleting it.

Design Intent in a Sketch T

Build design intent in a sketch as the profile is created. A )
profile is determined from the Sketch Entities. Example: SO
Rectangle, Circle, Arc, Point, Slot, etc. Apply symmetry ot Vertical
into a profile through a sketch centerline, mirror entity and /:( x /o
position about the reference planes and Origin. Always

Coincident Midpoint

know the location of the Origin in the sketch. “y
Build design intent as you sketch with automatic : : L oase
Geometric relations. Document the decisions made during o 7
the up-front design process. This is very valuable when Perpendiener fonaent
you modify the design later.
A rectangle (Center Rectangle Sketch tool)
contains Horizontal, Vertical, and Add Relations AN = /,/}
Perpendicular automatic Geometric % sm“ \\ 7 °
relations. . \i};-{/
Apply design intent using added Geometric ||| perendicuar " u
relations if needed. Example: Horizontal, || parale ,// N
Vertical, Collinear, Perpendicular, Parallel, % ig' v AN
Equal, etc. — ; ™

|
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Example A: Apply design intent to create a square

profile. Sketch a rectangle. Apply the Center Rectangle
Sketch tool. Note: No construction reference centerline or
Midpoint relation is required with the Center Rectangle

tool. Insert dimensions to fully define the sketch.

Example B: If you have a hole in a part that must always
be 16.5mm < from an edge, dimension to the edge rather
than to another point on the sketch. As the part size is

modified, the hole location remains 16.5mm < from the

edge as illustrated.

Design Intent in a Feature

Build design intent into a feature by addressing End
Conditions (Blind, Through All, Up to Next, Up to

Vertex, Up to Surface, Offset from Surface, Up to Body,

and Mid Plane), symmetry, feature selection, and the
order of feature creation.

Example A: The Extruded Base feature remains
symmetric about the Front Plane. Utilize the Mid
Plane End Condition option in Direction 1. Modify
the depth, and the feature remains symmetric about
the Front Plane.

Example B: Create 34 teeth in the model. Do you
create each tooth separately using the Extruded Cut
feature? No.

Create a single tooth and then apply the Circular
Pattern feature. Modify the Circular Pattern from
32 to 24 teeth.

Design Intent in a Part

Utilize symmetry, feature order and reusing
common features to build design intent into a part.
Example A: Feature order. Is the entire part
symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and
the inside corners remain perpendicular.
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Design Intent in an Assembly

Utilizing symmetry, reusing common parts and using
the Mate relation between parts builds the design

intent into an assembly.

Example A: Reuse geometry in an assembly. The
assembly contains a linear pattern of holes. Insert one
screw into the first hole. Utilize the Component
Pattern feature to copy the machine screw to the

other holes.

Design Intent in a Drawing

Utilize dimensions, tolerance and notes in parts
and assemblies to build the design intent into a

drawing.

Example A: Tolerance and material in the
drawing. Insert an inside diameter tolerance
+.000/-.002 into the Pipe part. The tolerance

propagates to the drawing.

SOLIDWORKS® 2020 Reference Guide
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01827 0%

o euns D&M ENGINEERING
me

TUBE

Define the Custom Property Material in the Part. e
The Material Custom Property propagates to
your drawing.
w1
* Create a sketch on any of the default planes:
Front, Top, Right, or a created plane or face.
SOLIDWORKS Design Intent tools
Comments
Add comments, notes or additional % ‘ =
information to features or sketches during i
the design period. This will aid you or FPO-2IN. B
your colleagues to recall and to better Go To...
understand the fundamental design intent [@sensors |Part (Part1)
of the model and individual features later. |’ @Annotatio  HiddenTreeltems -
. ' $% Material < Comm%c ’ ‘E Add Comment
Right-click on the name, feature, or (] FrontPlan ~ Tree Display ’
sketch in the FeatureManager. Click [1Top Plane) - Doshiment Proprties.
[J Right Plan Configuration Publisher...

Comment » Add Comment. The
Comment dialog box is displayed.

I_,Origin

#  Top Level Transparency

Appearance

Material

Purge Unused Features...
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Enter the information. Click Save and Close. A Comments folder
is displayed in the FeatureManager. Double-click the feature in
the Comments folder to view the comment.

n s
AT

You can also add a Date/Time stamp to your comment.

Design Binder

Activate the Design binder. Click Options & » System
Options tab > FeatureManager. Select Show from the drop-
down menu. The Design Binder is an embedded Microsoft Word
document that provides the ability for the user to capture a screen
image and to incorporate text into a document.

Design Intent, Sketching and Sketch Entities

[ FEN

|

‘% Part1 (Default<<Default>_D|
% Comments

E Comment1

=N

¢ BElReleT
g
% Part1 (Default<<Default>_D
- Comments
E Comment1

History

Sensors
% Design Binder

Design Journal.doc

ConfigurationManager 3

\Em b

When you create various configurations for assemblies,
design tables, etc., use the comment area to incorporate a

Configurations

v % Part1 Configuration(s)

comment for these configurations. v 1a Add Derived Configuration
w Preview

Dimensions s
To be efficient, reuse existing geometry. Provide Ny % 8 2 %S
dimensions with descriptive names. —

3.57in 2
Equations G

¢

SOLIDWORKS provides a completely redesigned dialog
box for creating and editing equations, global variables

@a Part2 (Default<<Default>_Dis
History

and dimensions. [ sensors
. . . 4 Design Binder
Add a comment to the end of an equation to provide clarity for P _
R i 4 Annotations
the future. Use descriptive names and organize your equations to P Euntions
improve clarity. 25 M Manage Equations...
m F ShoJ&ile Properties
w1 r
- . . . x Go To...
Create an Excel spread sheet to input your equations into
SOLIDWORKS. Use the Link to external file option.
Equations, Global Variables, and Dimensions
B ‘0.‘ 1% |v Filter All Fields ™
Name Value / Equation o sl 3 i
—Global Variables I—I
"GWidth" = "extrusion” - .8 2.93333 Cancel
| | "GHeight’ |= "height" - .19 1.67667
"Glength” = "length” *2-2 453333 import..
"HingeFeature’ =.5 0.5
"PinHoleFeatures" =.25 0.25 &l
| | "Velcro” =.15 0.15 Export...
| | "TensionTop" =3 3
"TensionTopOffset" =127 1.27 Help
"CableFeed" =.1 0.1 =
"CableFeedDistance” =.33 0.33 v
[ Automatically rebuild Angular equation units: | Degrees v Automatic solve order
\ Link to external file: ‘ C:\Users\Davep\Documents\2015 - 2016 Hand MQP\Final for Hand 4-28-2016\CAD 4-28-2016\Final Equation || __ ‘E‘
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w1

‘¥ Specify units of measurement for Global variables, and DIERE S
for the values and equations that define the global variables. & Boss-Extrudel @
You can define the units in the Equations and modify dialog | , | o
boxes for dimensions, and in PropertyManagers that support
equations' i Sketch Plane v X

Direction 1 ~
Design Tables Bind v
There are a number of ways to incorporate a comment into a 7
design table. One way is to add “SCOMMENT” to the {,\\‘:‘ -
heading of a column. This provides the ability to add a -
comment in a design table. . @00

Functions > ]

O oi v

Featu res ] File Properties >

Always use descriptive names in the FeatureManager
design tree, not the default feature names such as Boss- |-~~~
Extrudel, Cut-Extrudel, LPatternl, etc. Group %w key navigation

important features toward the top of the £ pynamic ighiight

FeatureManager design tree. [ Use transparent flyout FeatureManager tree in parts/assemblies

Scroll selected item into view

Enable FeatureManager tree filter

w [JAllow component files to be renamed from FeatureManager tree

“¥" Enable the FeatureManager Name feature on

creation option: click Options & » System Options > FeatureManager > Name
feature on creation box. The Name feature on creation option highlights the feature
name when created and allows the feature to be named.

Identify the Correct Reference Planes

Most SOLIDWORKS features start with a 2D sketch. Sketches are the foundation for
creating features. SOLIDWORKS provides the ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch Plane located on a Reference Plane, face or a
created place. 3D sketches are very useful in creating sketch geometry that does not lie on
an existing or easily defined Plane.

Does it matter where you start
sketching? Yes. When you create a
new part or assembly, the three
default planes are aligned with
specific views. The plane you select
for your first sketch determines the
orientation of the part. Selecting the
correct plane to start your model is
very important.
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2D Sketching/Reference Planes

The three default | reference planes,
displayed in the FeatureManager design tree,
represent infinite 2D planes in 3D space.
Front.

e Top.
e Right.

Planes have no thickness or mass.
Orthographic projection is the process of
projecting views onto parallel planes with L
projectors. The default L datum planes:

e Primary.
e Secondary.
e Tertiary.

Use the following planes in a manufacturing
environment:

e Primary datum plane: Contacts the part at

a minimum of three points.

Front

ight
Secondary Dajum
Terliary Datum

Top
PFrimary Dalum

e Secondary datum plane: Contacts the part at a minimum of two points.

e Tertiary datum plane: Contacts the part at a minimum of one point.

The part view orientation depends on the sketch plane. Compare the Front, Top and Right
Sketch planes for an L-shaped profile in the following illustration. Remember - the plane
or face you select for the base sketch determines the orientation of the part.

| SR

- 20-Profile - -+ FrontPlane - -+

----- TopPlane - - -Right-Planeq]
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The six principle views of Orthographic projection listed in the ASME Y 14.3 2009
standard are Front, Top, Right, Bottom, Rear, and Left. SOLIDWORKS Standard view

names correspond to these Orthographic projection view names.

ASME Y14.3 2009 Principle View Name: SOLIDWORKS Standard View:
Front Front

Top Top

Right side Right

Bottom Bottom

Rear Back

Left side Left

N}

ANSI is the default overall drafting standard
used in the book.

Wl B ]
oF

AR Displayed are the Front, Top, Right, and

Isometric views in Third Angle Projection. L

Tutorial: Default Reference Planes 4-1

Create a New part. Display the default Reference b M
planes in the Graphics window.

1. Click New D from the Menu bar. The

“* D&M ENGINEERING
e A

RIGHT ANGLE
o] A Part A

Templates tab is the default tab. Part is the
default template from the New
SOLIDWORKS Document dialog box.

2. Click OK. The Part FeatureManager is
displayed. Use the sketch Origin to understand
the (x-,y-) coordinate location of the sketch
and to apply sketch dimensions. Each sketch in the
part has its own Origin.

3. Click Front Plane from the FeatureManager design
tree. The Front Plane is the Sketch plane. The Front
Plane is highlighted in the FeatureManager and in the
Graphics window.

Show the default Reference planes in the Graphics window.
Select the Front, Top and Right planes.
4. Hold the Ctrl key down.

5. Click Top Plane and Right Plane from the
FeatureManager design tree.

Page 4 -8
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6. Release the Ctrl key.
7. Right-click Show ® from the Context toolbar.

8. Click inside the Graphics window. The three planes are
displayed in the Graphics window. Note the Plane icon in the
FeatureManager.

w1

“¥* Rename a feature or sketch for clarity. Slowly click the feature
or sketch name twice and enter the new name when the old one is
highlighted.

Rename the default Reference planes.
9. Rename the Front Plane to Front-PlateA.

10. Rename the Top Plane to Top-PlateB.
11. Rename the Right Plane to Right-PlateC.
12. View the results.

13. Close the model.

3D Sketching/Reference Planes

Create a 3D Sketch in SOLIDWORKS. A 3D Sketch is typically
used for advanced features such as Sweeps and Lofts or when the
sketch does not lie on an existing or easily definable plane. Most
basic features are created from a 2D Sketch.

There are two approaches to 3D Sketching. The first approach is
called 2D Sketching with 3D Sketch planes. In this approach, you:

1. Activate a planar face by adding a 3D Sketch plane.
2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you are required to move
sketch entities to create a 3D sketch.

Using the 2D Sketching with 3D Sketch planes approach provides
the ability to:

e Add relations:
e Between planes.
e Between sketch entities on different planes.
e To planes.
e Define planes.

e Move and resize planes.

Page 4 -9
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History
Sensors
4 Design Binder
Annotations
Equations

oy
2% Material <not specified

v

<
o

Section

© Bl&[@T
¢

@a Part1 (Default<<Default>_[
History

Sensors

Design Binder
Annotations

Equations

85 Material <not specified
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Tutorial: 3D Sketching 4-1

2 . .
Create a simple 3D Sketch on plane using the line sketch tool. J" o2 WORK; ng Ed;L
1. Create a New 0 part. Use the default ANSI Part template. SEtch sﬁn -G
Dimension
2. Click Top Plane from the FeatureManager. ﬁ@ - “©
ketch
3. Click the Sketch tab from the CommandManager. | Go 3o Skey
4. Click 3D Sketch On Plane from the Sketch Consolidated % Sk On Poe
toolbar as illustrated. 3DSketchl is active. Y
[@] Histo
5. Click the Line / Sketch tool. Se;js
6. Sketch a vertical line through the Origin. : ie“‘-’t”f‘”der
7. Right-click Exit Sketch (£ from the :“ta“."l”s .
Context toolbar. 3DSketchl is displayed in |2 £, s Yatetls o spectie
. o |2ﬁ\2 Front Pj#he
the FeatureManager and is under defined. [[TopPens
% Select m P——
8. Close the model. S e ’ g rene
Recent Commands > I_. Orlgll’l

Tutorial: 3D Sketching 4-2
Create the illustrated model. Insert two features: Boss-
Extrudel and Cut-Extrudel. Apply the 3D Sketch tool

to create the Cut-Extrudel feature. System units =
MMGS.

1. Create a New LJ part in SOLIDWORKS. Use the
default ANSI, MMGS Part template.

2. Right-click Front Plane from the FeatureManager. Origin
This is your Sketch plane.

4 Annotations
3. Click Sketch {_ from the Context toolbar. The F%] Equations
Sketch toolbar is displayed. NG
P =R
4. Click the Corner Rectangle I tool from the 7 S —
Consolidated Rectangle Sketch toolbar. The 0 Sketch On Plane

PropertyManager is displayed.

5. Sketch a rectangle as illustrated. The part Origin is
located in the bottom left corner of the sketch.

Insert dimensions.

6. Right-click Smart Dimension ¢ from the
Context toolbar.

7. Dimension the sketch as illustrated. The sketch is
fully defined. The sketch is displayed in black.

‘/’ ‘\v
‘/ \»
7 N,
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Create the first feature for the model. The Extruded Boss/Base
feature adds material to a part. Extrude the sketch to create the
first feature. Apply symmetry.

8. Click Extruded Boss/Base ®l from the Features toolbar.

9. Select the Mid Plane End Condition in Direction 1. Enter
100.00mm for Depth in Direction 1. Accept the default

conditions. Click OK ¥ from the Boss-Extrude
PropertyManager.

w s

“¥" The Instant3D tool provides the ability to drag geometry
and dimension manipulator points to resize features or to create
new features directly in the Graphics window. Click the face.
Select a manipulator point. Click and drag. Click a location
along the ruler for the required dimension. The ruler increments

are set in System Options.

10. Create 3DSketchl. 3DSketchl is a four point sketch. Click
3D Sketch On Plane from the Consolidated Sketch toolbar
as illustrated.

11. Click the Line e Sketch tool. 3DSketchl is a four point
sketch as illustrated. 3DSketch1 is the profile for Cut-
Extrudel.

12. Locate the first point of the sketch. Click the back right
bottom point as illustrated. Locate the second point of the
sketch. Click the top left front point as illustrated. Locate
the third point of the sketch.

13. Click the bottom right front point as illustrated.
Locate the fourth point of the sketch.

Design Intent, Sketching and Sketch Entities

S ERl¢I@ T
@) Boss-Extrude @
A x @
From ~
‘Sketch Plane w ‘

Diregtion 1 ~
Mid Plane v

| =]

Draft outward
[ Thin Feature v
Selected Contours v
7 -
DS SOLIDWORKS | File Ed
Sketch| Smart D -y
Dimension
. 20

Sketch

| (Go 3D Sketch

Ap 3D Sketch On Plane

14. Click the back right bottom point as illustrated to close the sketch.

S PV

XY A

Create the Cut-Extrudel feature.
15. Click Extruded Cut '@ from the Features toolbar.
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16. Click the front right vertical edge as illustrated to remove

the material. Edge<1> is displayed in the Direction of
Extrusions box.

17. Click OK ¢ from the Cut-Extrude PropertyManager.
Cut-Extrudel is displayed in the FeatureManager.

18. Close the model.

w1
“¥* Select the front right vertical edge or the Top face to
remove the required material in this tutorial.

The second approach to create a 3D Sketch in SOLIDWORKS
is 3D Sketching. In this approach:

1. Open an existing 3D Sketch.

2. Press the Tab key each time you need to move your sketch
entities to a different axis.

The sketch origin is placed wherever you start the
sketch.

Tutorial: 3D Sketching 4-3
Apply the 3DSketch tool to create a 3DSketch
using the Tab key to change Sketch planes.

1. Open 3D Sketching 4-3 from the
SOLIDWORKS 2020 folder.

Edit the 3D Sketch.
2. Right-click 3DSketch from the

FeatureManager. Click Edit Sketch @ from
the Context toolbar. 3DSketchl is displayed in
the Graphics window.

3. Click the Line / Sketch tool. Note: The
mouse feedback icon.

4. Click the right endpoint of the sketch as
illustrated.

5. Press the Tab key to change the Sketch plane
from XY to YZ. The YZ icon is
displayed on the mouse pointer.

6. Sketch a line along the Z axis
approximately 130mm as illustrated.

7. Press the Tab key twice to change the
sketch plane from YZ to XY. The XY
icon is displayed on the mouse pointer.

Page 4 - 12
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Sketch a line back along the X axis approximately
30mm.

9.
10.

Deselect the Line Sketch tool.
11. Right-click Select.

12. View the 3D Sketch.

Sketch a line on the Y axis approximately 30mm.

Sketch a line along the X axis of approximately 130mm.

Design Intent, Sketching and Sketch Entities

X
ZHr—

5.07

13. Close the model.

Tutorial: 3D Sketching 4-3A

Apply the circle sketch tool to create a Sweep along a 3D
sketch.

1. Open 3D Sketching 4-3A from the SOLIDWORKS
2020 folder.

Create the 2D sketch.

g\\@\@\elﬁ“ﬁ

@& @ 3D Sketching 4-3A (DefaL

4 History

4 Design Binder
4 Annotations

Sensors

Equations

§5 Material <not specified>
[Q Front Plane

& Top Pli—=
[ &ight Fro °Ld

1, Origin [Sketch| (Right Plane)

(o 30Skef [y 3D Sketch On Pig

2. Right-click Right Plane from the FeatureManager.
3. Click Sketch.

4. Display a Right view.

5. Sketch a circle at the origin as illustrated.

Create a Swept Boss feature.
6. Click Swept Boss/Base from the Features
CommandManager.

JDZ?SOLIDWORKS‘ File Edit View  Insert Tools Window Help X

Click the Circular Profile box.

Extruded Revolved
Boss/Base Boss/Base

Enter .10in for diameter.

ﬁ 3 f Swept B]}\?/Base

Swept Boss/Base

Sweeps a closed profile along an
open or closed path to create a solid
feature.

Path(3DSketch1)

9. Click the 3D Sketch (path) in the graphics Features | Sketch | Evaluate ||
window.

10. Click OK.

11. View the results in the graphics P no——
window. =

12. Close the
model.

)
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Tutorial: 3D Sketching 4-4

Utilize the 3D Sketch placement method. Insert a hole on a
cylindrical face using the Hole Wizard.

1. Open 3D Sketching 4-4 from the SOLIDWORKS
2020 folder. Note: With a 3D sketch, press the Tab key
to move between planes.

2. Click the Hole Wizard & feature tool.

Create a Counterbore, ANSI Inch, Socket Head Cap
Screw fastener Type. Size - V4. Fit - Normal. End
Condition - Through All with a .100in Head
clearance.

4. Click the Positions Tab.

5. Click the 3D Sketch button. The Hole Position
PropertyManager is displayed. SOLIDWORKS

displays an active 3D interface with the Point XY « tool.

w1

- "

When the Point tool is active, wherever you click,
you will create a point.

Dimension the sketch.

6. Click the cylindrical face of the model as illustrated.
The selected face is displayed in orange. This indicates
that an OnSurface sketch relation will be created
between the sketch point and the cylindrical face. The
hole is displayed in the model.

7. Insert a .25in dimension between the top face and the
sketch point.

Locate the point angularly

around the cylinder. Apply

construction geometry.

8. Display the Temporary
Axes.

o
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Hole Specifications / A
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9. Click the Line e Sketch tool. Note: 3D Sketch is still
activated.

10. Ctrl + Click the top flat face of the model. This moves the
red space handle origin to the selected face. This also
constrains any new sketch entities to the top flat face. Note

the mouse pointer ¥ « icon.

11. Move the mouse pointer near the center of the activated
top flat face as illustrated. View the small black circle. The
circle indicates that the end point of the line will pick up a
Coincident relation.

12. Click the center point of the circle.

13. Sketch a line so it picks up the AlongZ sketch relation.
The cursor displays the relation to be applied. This is a
very important step.

Deselect the Line Sketch tool.
14. Right-click Select.

15. Create an AlongY sketch relation between the || 2% | atong x
center point of the hole on the cylindrical face v | Along Y
and the endpoint of the sketched line. The ‘%
sketch is fully defined. Note: Add any A
additional relation if needed. r

16. Click OK ¢ from the PropertyManager.

17. Click OK ¥ to return to the Part
FeatureManager.

Along Z

Coincident

Fix

18. Expand the FeatureManager and view
the results. The two sketches are fully
defined. One sketch is the hole profile;

$\H%\$\0\W

% 3D Sketching 4-4 (Default<<D4
» History

the other sketch is to define the position 2 Sensors
Of the featul’e. 4 Design Binder
4 Annotations
19. Close the model. » [§@) Solid Bodies(1)
. Equations
Ly . . . . 835 1060 Alloy
Create a second sketched line and insert an angle dimension ) Front Plane
between the two lines. This process is used to control the position (] Top Plane
of the center point of the hole on the cylindrical face as ER“B“ Plane
Origin

illustrated. Insert an AlongY sketch relation between the center
point of the hole on the cylindrical face and the end point of the (3 CBORE for 1/4 Socket Head
second control line. Control the hole’s position with an angular /rv (30 3Dsketcht
dimension. L Sketch

4 ﬂ Boss-Extrude1
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The main advantage of the 3D Sketch placement method is that it can place a set of holes
on any set of solid faces, regardless of whether they are at different levels, or are non-
parallel. A limitation: 3D sketches can be fairly cumbersome and difficult. See section on
3D Sketching in SOLIDWORKS Help for additional details.

2D Sketching/Inserting Reference Planes

oL
O
Reference Planes are geometry created from existing planes, faces, | Reference Curves|instant3n
vertices, surfaces, axes, and or sketch geometry. To access the Geometry
Plane PropertyManager, click Insert > Reference Geometry > IC e
Plane from the Menu bar or click the Plane M tool from the 2 Ais %
Consolidated Reference Geometry Features toolbar. 4+ Coordinate System
° Point
Oy & Center of Mass
“¥" The dimensions of a bounding box can help you determine ® Bounding Box
the space required to ship and package product. Calculating a ) Mate Reference
bounding box for a part with many faces can be time consuming. If
a part has many faces, create the bounding box after you finish i
modeling the part. di
Plane Tool

The Plane ® tool uses the Plane PropertyManager. The Plane
PropertyManager provides the following selections:

o First Reference. Select a face, plane or S ERoe.
«|»
edge to create a reference plane. The N =
. Pl
options are: ane e
. v X ~B
¢ Reference Entities. Display the Hessage
. Message A Fully defined
selected planes either from the :
. Select references and First Reference N
FeatureManager or from the Graphics | constraints @
WindOW. First Reference A Parallel
e Parallel. Create a plane parallel to the | @ I | Perpendicular
selected plane. For example, select a S —— ~ Coincident
face for one reference and a point for all | 90.00deg
another reference. The created plane is (Bl S
parallel to the face and coincident to e Ttz e 2 3_”"”””‘
. 1 C))
@ Mid Plane
e Perpendicular. Create a plane Options A || second Reference ~
perpendicular to the selected reference. Al L] el |
For example, select an edge or curve Third Referance ~
for one reference and a point or vertex el |
for another reference. —
ptions A
[ Flip normal v
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e Coincident. Create a plane
through a point coincident to a
plane or a face.

e Project. Project a singular entity
such as a point, vertex, origin, or
coordinate system onto a non-
planar surface. Select the sketch
point and the model surface. Two
options appear in the
PropertyManager:

e Nearest location on surface.
e Along sketch normal.

e Tangent. Create a plane tangent to
cylindrical, conical, non-
cylindrical, and non-planar faces.
Select a surface and a sketch point
on the surface. The plane is
created tangent to the surface and
coincident to the sketch point.

Design Intent, Sketching and Sketch Entities

S ER[¢[@[T

S| E B[S [@f )]

' Plane @
v X -

Message ~
Select references and
constraints

First Reference A
Second Reference A
Third Reference A
Options A

Flip normal

e At Angle. Select a plane or planar face and select
an edge, axis, or sketch line. You can specify the
number of planes to create. Enter the angle value in

the angle box.

e Offset Distance. Create a plane parallel to a plane
or face, offset by a specified distance. You can
specify the number of planes to create. Enter the
Offset distance value in the distance box.

e Reverse direction. Reverse the direction of the

angle if required.

e Numbers of Planes to Create. Display the

selected number of planes.

e Mid Plane. Create a mid-plane between planar
faces, reference planes, and 3D sketch planes.

Select Mid Plane for both references.
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v X ™

Message A A
Fully defined

First Reference A

C
Parallel
Perpendicular
Coincident
90.00deg

O Flip offset
]
EI Mid Plane

e

«e

Second Reference ~
Third Reference A
Options ~

] Flip normal v
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Tutorial: Reference Plane 4-1
Create three Reference planes using the Offset Distance option from
the Plane PropertyManager.

1. Create a New L part. Use the default ANSI Part template. Set
system units to MMGS.
2. Display an Isometric view.

3. Right-click Top Plane from
the FeatureManager design
tree.

4. Hold the Ctrl key down.

5. Click and drag the
boundary of the Top Plane
upwards in the Graphics
window. The Plane
PropertyManager is
displayed. Top Plane is displayed in the First Reference box.

Release the Ctrl key and mouse pointer.
Enter 25mm in the Distance. The Plane is offset by 25mm.

Enter 3 in the Number of planes to create box.

A S

Click OK ¥ from the Plane PropertyManager.
Planel, Plane2 and Plane3 are created and
displayed in the Graphics window. Each Plane is
offset from the Top Plane a distance of 25mm.

10. Close the model.

Tutorial: Reference Plane 4-2

Use the Plane PropertyManager to create two angled

Reference planes from an edge at a 45 degree angle.

1. Open Reference Plane 4-2 from the
SOLIDWORKS 2020 folder.

2. Click Right Plane from the FeatureManager
design tree.

3. Click Insert > Reference Geometry > Plane
from the Menu bar. The Plane PropertyManager is
displayed. Right Plane is displayed in the First
Reference box.

4. Click the At angle button.
5. Enter 45deg for Angle.
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SIERBIS|@LT
' Plane @
v X =

Message A
Fully defined

First Reference A

0
Parallel
Perpendicular
Coincident
90.00deg

[ Flip offset
+
Ig Mid Plane

b

o

Second Reference ~

el |

Third Reference A

ol |
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6. Click the front vertical edge of Extrudel as illustrated. Do not select the midpoint.
Edge<1> is displayed in the Selections box. The model is fully defined.

7. Enter 2 in the Number of planes to create box.

8. Click OK ¥ from the Plane PropertyManager. Planel and
Plane2 are displayed in the FeatureManager and in the
Graphics window.

9. Close the model.

Tutorial: Reference Plane 4-3

Use the Plane PropertyManager to create a Reference plane using

three vertices (Coincident) to the Extrudel feature.

1. Open Reference Plane 4-3 from the SOLIDWORKS 2020
folder.

2. Click Insert > Reference Geometry > Plane. The Plane
PropertyManager is displayed.

3. Click three Vertices as illustrated. Vertex<1>, Vertex<2>

and Vertex<3> are displayed in the Reference Entities boxes.

The model is fully defined.

4. Click OK ¥ from the
Plane PropertyManager.
The angled Planel is
created and is displayed
in the FeatureManager
and the Graphics
window.

5. Close the model.

A Fully define all
sketches in the model.
However, there are times when
this is not practical, generally
when using the Spline tool to
create a complex freeform
shape.
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Tutorial: Reference Plane 4-4

@ .

Use the Plane PropertyManager to create a Reference plane » ﬂ CU by

parallel to an existing plane, through a selected point. oty

1. Open Reference Planes 4-4 from the SOLIDWORKS 2020 /.g"'m =
fOlder. /;! A)‘::e%

2. Click the Plane ¥ tool from the Consolidated Reference }’ (P:z; idi”ate e
Geometry Features toolbar. The Plane PropertyManager is & Center of Mass
displayed. @ Bounding Box

ﬁ@ Mate Reference

3. Click the front top right vertex.

4. Click the Right Plane from the fly-out FeatureManager.
The model is fully defined.

5. Click OK ¥ from the Plane PropertyManager. Planel
is created and is displayed in the FeatureManager and
Graphics window. Close the model.

Boss-Extrude1

Parent/Child Relationship

A Parent feature or sketch is an existing feature or sketch on which others depend.
Example of a Parent feature: An Extruded feature is the Parent feature to a fillet which
rounds the edges.

When you create a new feature or sketch which is based on other features or sketches,
their existence depends on the previously built feature or sketch. The new feature or
sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is
the child of the Base-Extrude feature in which it is cut.

Tutorial: Parent-Child 4-1

. . . L. 4 @ (f) NCJ22005Z-MP<1:
View the Parent/Child relationship in an assembly for a + @ RodClevis<1> (Defaul
feature and a sketch from a component. v [§] Mates in AirCylinc
1. Open the AirCylinder Linkage assembly from [@] History
the SOLIDWORKS 2020\Solutions folder. [ sensors
4 Design Binder
2. Expand RodClevis<I> from the AirCylinder » [A] Annotations ]
Linkage assembly FeatureManager. » [@]Solid Bodies(1)
. . Equations
3. Right-click Base-Extrude. 355 Material <not spe
4. Click Parent/Child. The Parent/Child g fron
. . . . . . op
Relat10nsh1p§ dlalqg box is displayed. View the 1 Right
Sketch?2 relationships. 1, origin
5. Click Close from the Parent/Child Relationships R vt S
dialog box. » (@ Cut-Extrudes ~—SKetRT———1
@ Chamfer2
4 Cut-Extrude5 2,
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View the Parent/Child Relationships for a feature. -

6. Right-click Sketch2 from Base-Extrude in the | ®Prenyenid felstonships x
FeatureManager design tree. Erurs g

7. Click Parent/Child. View the Base-Extrude EZ‘T"f Y pase Brnde
feature relationships. ’

8. Click Close from the Parent/Child
Relationships dialog box.

9. Close the model.

Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status

bar at the bottom of the SOLIDWORKS window. There are five sketch states in

SOLIDWORKS:

w e
“¥* Color indicates the state of the individual Sketch entities.

1. Under Defined. Inadequate definition of the sketch, (blue). The FeatureManager
displays a minus (-) symbol before the Sketch name.

2. Fully Defined. Complete information, (black). The FeatureManager displays no
symbol before the Sketch name.

3. Over Defined. Duplicate dimensions and or relations, (orange -red). The
FeatureManager displays a (+) symbol before the Sketch name. The What’s Wrong
dialog box is displayed.

4. Invalid Solution Found. Y our sketch is solved but results
in invalid geometry; for example, a zero length line, zero
radius arc or a self-intersecting spline (yellow).

5. No Solution Found. Indicates sketch geometry that cannot = —
be resolved, (Brown). 5 ‘ ‘ 5 ‘ & ‘ @ .

SketchXpert is designed to assist in an over defined state of a % SkatchXpert @

sketch. SketchXpert generates a list of causes for over defined | Y *

sketches. The list is organized into Solution Sets. This tool Message ~

enables you to delete a solution set of over defined dimensions | press “Diagnose"” to find solutions

or redundant relations without compromising your design to the sketch error.

intent.

e Press "Manual Repair” to list all
/Q\ Clle Options {é} > [ Auto-rotate view normal to sketch plane on sketch the relations with errors.

System Options > SketCh, and @Jsefullydeﬁned sketches Manual Repair

Cllck the Use fully deﬁned Display arc centerpoints in part/assembly sketches

sketches Optlon tO use fully Display entity points in part/assembly sketches More Informationlf)ptions e

defined sketches for created [ Prompt to close sketch |:|A|r\:vay5k0[;err]1 this dialog

[[] create sketch on new part when sketch error occurs
features.
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A Apply dimensions and relations calculated by the SOLIDWORKS application to

fully define sketches or selected sketch entities. Use the Fully Defined Sketch

PropertyManager.

Sketch Entities

Sketch entities provide the ability to create lines,
rectangles, parallelograms, circles, etc. during the
sketching process. To access the available sketch
entities for SOLIDWORKS, click Tools > Sketch
Entities from the Menu bar menu and select the
required entity. This book does not go over each
individual Sketch entity in full detail but will

@ Ellipse
6: Partial Ellipse
U Parabola

f\ Conic

fu Spline

N Style Spline

(@ Spline on Surface
‘ﬁ Equation Driven Curve
®  Point

s .
" Centerline

\\ Midpoint Line

/ Line

1 Corner Rectangle

=1 Center Rectangle

<> 3 Point Corner Rectangle
<> 3 Point Center Rectangle
[7 Parallelogram

Straight Slot
Centerpoint Straight Slot
3 Point Arc Slot
Centerpoint Arc Slot

(> Polygon

@ Circle

address the more advanced entities. A Text.. O Perimeter Circle
Plane 0 Centerpoint Arc
To obtain additional information of each sketch D) Tangeni Arc
entity, activate the sketch entity and click the b Sl
question mark @ icon located at the top of the Customize Menu
entity PropertyManager or click Help »
SOLIDWORKS Help Topics from the Menu bar
and search by using one of the three available tabs:
Contents, Index, or Search.
- . = | E=Y
Line Sketch Entity SiElBlelen:
./ Insert Line @
The Line Sketch entity >’ tool provides the ability to sketch v X
multiple 2D lines in a sketch. The Line Sketch entity uses the Message ~

Insert Line PropertyManager. The Insert Line PropertyManager

provides the following selections:

e Orientation. The Orientation box options are:

e As sketched. Sketch a line in any direction using the
click and drag method. Using the click-click method, the
As sketched option provides the ability to sketch a line in
any direction, and to continue sketching other lines in any
direction, until you double-click to end your process.

e Horizontal. Sketch a horizontal line until you release

your mouse pointer.

Edit the settings of the next new
line or sketch a new line.

Orientation A

@As sketched
O Horizontal
OVerticaI

OAngIe

Options ~

D For construction
[ infinite length
Ol Midpoint line

e Vertical. Sketch a vertical line until you release your

mouse pointer.

e Angle. Sketch a line at an angle until you release your

mouse pointer.
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e Options. The line type options are:

¢ For construction. Convert the selected sketch entity to
construction geometry.

e Infinite length. Create a line of infinite length which you

can later trim in the design process.

e Midpoint line. Create a line that is symmetrical from the
midpoint of the line.

e Parameters. Specify any appropriate combination of the

following parameters (or Additional Parameters) to define the

Design Intent, Sketching and Sketch Entities

Orientation 2
O As sketched
@ Horizontal
O Vertical
O Angle
Options ~
|:| For construction
|:| Infinite length
] Midpoint line

Parameters 2

Nl N

|l“ 0.00°

line if the line is not constrained by relations. When you change
one or more parameters, the other parameters update automatically.

w1

“¥* Use Construction geometry to assist in creating your sketch entities and geometry

that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.

Rectangle and Parallelogram Sketch
Entity

The Rectangle Sketch entity EA tool provides the ability to
sketch a Corner Rectangle, Center Rectangle, 3 Point Corner
Rectangle, and a 3 Point Center Rectangle. The Parallelogram
Sketch entity provides the ability to sketch a Parallelogram.

The Rectangle and Parallelogram Sketch entity uses the
Consolidated Rectangle PropertyManager.

e Rectangle Type. The rectangle type options are:

e Corner Rectangle. Sketch a standard rectangle at a
corner point. Click to place the first corner of the
rectangle, drag, and release when the rectangle is the
correct size and shape.

e Center Rectangle. Sketch a rectangle at a center point.
Click to define the center. Drag to sketch the rectangle
with centerlines. Release to set the four edges.

e 3 Point Corner Rectangle. Sketch a rectangle at a
selected angle. Click to define the first corner. Drag,
rotate, and then release to set the length and angle of the
first edge. Click and drag to sketch the other three
edges. Release to set the four edges.
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¢ 3 Point Center Rectangle. Sketch a rectangle with a center

Rectangle Type &
point at a selected angle. Click to define the first corner. g y.,z
Drag and rotate to set one half the length of the centerlines. .
Click and drag to sketch the other three edges and 0 & O
centerlines. Release to set the four edges. %AS construction fines

From Corners
e Parallelogram. Sketch a standard parallelogram. A O fFrom Midpoints

Parallelogram is a rectangle whose sides are not horizontal — |parameters ~
or vertical with respect to the sketch grid. Click to define w0
the first corner. Drag, rotate, and then release to set the * 000

length and angle of the first edge. Click, rotate, and drag to * 000
set the angle and length of the other three edges. Release to °, 000

set the four edges. ., |00
e Add construction lines. Convert the entities to construction v [
geometry. w00

o 1 0.00
e From Corners. Add centerlines from corner to corner.

e From Midpoints. Add centerlines from midpoint of line T ER[E[@T
segments. slot ®
e Parameters. Specify the appropriate combination of parameters v
to define the rectangle or parallelogram if they are not e e -
constrained by relations.
Slot Sketch Entity [ add dimensions
The Slot Sketch entity >’ tool provides the ability to sketch a : i
Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot and a Options _ %
Centerpoint Arc Slot from the Consolidated Slot toolbar. ey
Parameters &
The Slot Sketch entity uses the Consolidated Slot G, ©.00mm
PropertyManager. The Slot PropertyManager provides the @, 0.00mm
following selections: @  000001mm
e Slot Type. The Slot type options are: G 0oo00imm
e Straight Slot. Sketch a three point
slot. o o
! / g
e Centerpoint Straight Slot. . 5 . Y
Sketch a three point slot located ] f / ]

at an Origin or centerpoint.

e 3 Point Arc Slot. Sketch an arc slot using three points
along the arc.

e Centerpoint Arc Slot. Sketch an arc slot using the
center point of the arc and the two end points.
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Add dimensions. Insert dimensions as you sketch
the slot.

Center to Center. Insert center to center dimension
if the Add dimensions box is checked.

Overall Length. Insert overall length if the Add
dimensions box is checked.

Parameters. Specify the appropriate combination of
parameters to define slot if they are not constrained
by relations. The options are: Center X
Coordinate, Center Y Coordinate, Radius of Arc,
Angle of Arc, Slot Width, Slot Length.

Tutorial: Slot Sketch - Instant3D 4-1

Utilize the Slot Sketch tool. Create an Extruded Boss/Base
and Extruded Cut feature using the Instant3D tool.

1.

Dimension the slot sketch.
8.

Create a New |J part. Use the default ANSI, IPS
Part template.

Right-click Front Plane from the FeatureManager.

Click Sketch il from the Context toolbar. The Sketch
toolbar is displayed.

Click Centerpoint Straight Slot @ from the
Consolidated Slot toolbar as illustrated. The Slot
PropertyManager is displayed. If needed, uncheck the
Add dimension box.

Click the Origin.

R.51

Design Intent, Sketching and Sketch Entities

287

1% B

DAdd dimensions

Op| Center to Center 2

|:| For construction

Parameters XD

(:x 0.00mm

0.00mm

0.0000Tmm

O
@ 0.00001mm
P=]
o

CTTOTY
oo M- .
Straight Slot
Centerpoint Straight Slot

' 3 Point Arc Slot

Centerpoint Arc Slot

Click a position directly to the right of the
Origin.

Click a position directly above the second
point as illustrated.

Right-click Smart Dimension € from the

Context toolbar in the Graphics window. (

Dimension the model as illustrated. The

sketch is fully defined. Note the location of

the Origin.
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Apply the Instant3D tool. Create an Extruded Boss/Base feature. The

Extruded Boss/Base feature adds material to a part. Note: Edit the ‘" U P
feature, and view the PropertyManager to confirm that you picked Reference Curves (jnstantaD
the correct dimension with the on-screen ruler. The Instant3D tool oeometry

does not provide various End Conditions for Design Intent.

Exit Sketchl.

10. Right-click Exit Sketch & Note: Instant3D
is active by default. If needed click Instant3D
from the Features tab.

11. Display an Isometric view.

Create an Extruded Boss/Base feature with a

default Blind End Condition.

12. Click the top edge as illustrated. A green
arrow is displayed. Drag the arrow forward
and click the on-screen ruler approximately
0.25in.

13. View Boss-Extrudel in the FeatureManager. Loz ~
14 Blind v
»

. Edit Boss-Extrudel in the FeatureManager.

15. Enter Depth = .30in. Click OK + from the I
PropertyManager. %.mm 5
Create an Extruded Cut feature using Instant3D. | =

16. Display a Front view.

Draft outward

17. Right-click the Front face. This is your Sketch plane.

18. Click Sketeh  from the Context toolbar. The Sketch toolbar
is displayed.

19. Click the Circle ©) Sketch tool.

20. Sketch a circle centered at the Origin as illustrated.

Exit the Sketch.
21. Right-click Exit Sketch. Display an Isometric view.

Create an Extruded Cut feature.
22. Click the circumference of the sketch as illustrated.

23. Click and drag the arrow backwards to create a hole in the
model. Note: The default End Condition is Blind.

24. Release the mouse icon behind the model. The Cut-Extrudel
feature is displayed. View the model.

25. Close the model.
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Polygon Sketch Entity

G ERI¢|@T
The Polygon Sketch entity é\, tool provides the ability to create (O Polygon @
equilateral polygons with any number of sides between 3 and 40. |v
The Polygon Sketch entity uses the Polygon PropertyManager. Options ~
The Polygon PropertyManager provides the following options: [ For construction

Parameters 2

o Existing Relations. Display information on existing relations @ D .
of the polygon sketch. v

@ Inscribed circle
e Add Relation. Display the selected relations to the points and O circumscribed circle
lines of your polygon sketch.

©

w1
“¥* You cannot add a relation to a complete polygon.
You can only add a relation to the points and lines of

the polygon.

173.20508076

M O

©

<

o

o

S

°

SEY K12 BT K

New Polygon

e Options. The option:

e For construction. Not selected by default.
Convert the selected sketch entity to
construction geometry.

e Parameters. Specify the appropriate combination
of parameters to define the polygon. When you
modify or change one or more parameters, the
other parameters update automatically. The
options are:

e Number of Sides. Set the number of sides in
your polygon.

e Inscribed circle. Selected by default. Display
an inscribed circle inside the polygon. Define
the size of the polygon. The circle is
construction geometry.

e Circumscribed circle. Display a
circumscribed circle outside of the polygon.
Define the size of the polygon. The circle is
construction geometry.

e Center X Coordinate. Display the X
coordinate for the center of your polygon.
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e Center Y Coordinate. Display the Y coordinate
for the center of your polygon.

e Circle Diameter. Display the diameter of the
inscribed or circumscribed circle.

e Angle. Display the angle of rotation.

e New Polygon. Create more than a single polygon
without leaving the PropertyManager.

Tutorial: Polygon 4-1

Create a new part using the Polygon Sketch entity.

1. Create a New L] part. Use the default ANSI Part
template.

2. Right-click Top Plane from the FeatureManager
design tree. This is your Sketch plane.

3. Click Sketch & from the Context toolbar. The Top
Plane boundary is displayed in the Top view.

4. Click the Cirele & Sketch tool. The Circle
PropertyManager is displayed.

5. Sketch a circle centered at the origin.

Insert a polygon.

6. Click Tools > Sketch Entities > Polygon from the

Menu bar or click Polygon from the Sketch toolbar.
The Polygon PropertyManager is displayed.

7. Sketch a Polygon centered at the Origin larger than
the circle as illustrated.

8. Click OK ¥ from the Polygon PropertyManager.

9. Rebuild 9 the model. View the created Polygon in

the Graphics window.
10. Close the model.

“¥* For illustration purposes, the Reference planes and
grid are hidden.
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@ Inscribed circle

O Circumscribed circle
& |0.000 ‘ .
& |0.000 ‘ .
Q 2.69963423 ~
v
a o ~
w0

ZNew Polygon

/-
=-

the number of sides after sketching

0
~ @ Entities Entlvtles Entities
h | Evalt pg Iygon

V- ¥ U [T 1
@ A Trim  Convert (ffset E
_\

Sketches a polygon. You can change

the polygon.
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Circle Sketch and

. . §E[RISI@T) | S ElRle[@T
Perimeter Circle Sketch O circle @ | | O circe ®
Entity M
The Circle Sketch and Perimeter Circle Circle Type Al =™ )
Sketch entity % tool provides the ability Q§
to control the various properties of a options Perimeter Circle
circle. For construction
The Circle Sketch and Perimeter Circle e 1 ® Under Defined
Sketch entity uses the consolidated Circle | &« 0 dd Relations N
PropertyManager. The consolidated (=, 000 F‘.X
Circle PropertyManager provides the

. . f( e Options A
fOHOWlng OptlonS: [JFor construction
e Circle Type. Select either a center- Parameters ~

based circle or a perimeter-based %
circle sketch entity. e

e [Existing Relations. The Existing Relations box provides the A
following option:

<> <> <>

e Relations. Display the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

e Add Relations. Add relations to the selected entity. Display the relations which are
possible for the selected entity.

e Options. For construction. Not selected by default. Convert the selected entity to
construction geometry.

e Parameters. Specify the appropriate combination of parameters to define the circle if
the circle is not constrained by relations. The options are:

e Center X Coordinate. Set the Center X Coordinate value.
e Center Y Coordinate. Set the Center Y Coordinate value.

e Radius. Set the Radius value.

Page 4 - 29



Design Intent, Sketching and Sketch Entities SOLIDWORKS® 2020 Reference Guide

The Perimeter Circle Sketch entity provides the ability to define a circle using 3 points
along its perimeter. This sketch entity is very useful when you are not concerned about
the location of the center of the circle.

Tutorial: Perimeter Circle 4-1
Create a Perimeter Circle sketch.
1. Create a New [ part. Use the default ANSI Part template.

2. Right-click Front Plane from the FeatureManager. This is
your Sketch plane. T__

3. Click Sketch i from the Context toolbar.

4. Click the Line e Sketch tool. The Insert Line
PropertyManager is displayed.

5. Sketch two lines as illustrated.

Sketch a circle that is tangent to both lines.
6. Click Perimeter Circle from the Consolidated Circle
Sketch toolbar. The Circle PropertyManager is displayed.

Perimeter Circle

7. Click each line once.

8. Click a position as illustrated to determine the size
of the circle. The X coordinate, Y coordinate, and
Radius are displayed in the Parameters box. The x
two lines are tangent to the circle. You created a o
simple circle using the Perimeter Circle sketch u
entity.

9. Click OK ¥ from the Circle PropertyManager.
View the model. &

10. Rebuild 8 the model.
11. Close the model.

w s

“¥" If the two lines change, the circle remains tangent
to the lines.

Ry . . .
- Line length measured between virtual sharps in 3d
FAY AN

In System Options, under the Sketch folder, apply | Fenabie spiine tangency and curvature handies
the Ghost image on drag option. The option displays a ['show spline control polygon by default
ghost image of a sketch entity’s original position while Ghost image on drag
you drag the sketch in the Graphics window. %

Show curvature comb bounding curve

Scale sketch on first dimension creation

[CJEnable on screen numeric input on entity creation
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Centerpoint Arc Sketch
Entity

The Centerpoint Arc Sketch entity & tool
provides the ability to create an arc from a

center point, a start point, and an end point.

The Centerpoint Arc Sketch entity uses the
consolidated Arc PropertyManager.

The Arc PropertyManager controls the
properties of a sketched Centerpoint Arc,
Tangent Arc, and 3 Point Arc.

The consolidated Arc PropertyManager
provides the following options:

e Arc Type. Select a Centerpoint Arc,
Tangent Arc, or 3 Point Arc sketch
entity.

e Existing Relations. The Existing Relations box provides the

following option:

e Relations. Display the automatic relations inferenced during
sketching or created manually with the Add Relations tool.

Design Intent, Sketching and Sketch Entities

S ERS@T e=ERee™
A\ Arc @ D Arc @
o v

Arc Type ~ Arc Type ‘=

2 3

2 3 - 3 03 _13
1 ; ) m ; 2 ﬂ
pay Centrepoint Arc N E{ Centrepoint Arcl A

(3; 0.00 b
(5; 0.00
@  Under Defined
G 0.00 -
Add Relations la
G o
(:; 0.00 Options A
For construction
(T; 0.00 O
Parameters A

0.00 _
(o; 22.77143439
0.00° (o\.’ 4.02386792

%3

"
v
~
v

G 10.33402444 »

C\ -3.29225557 ~

v v

. "

(:; 48.33215841 .
(T; 26.29821315 »
v

<
|l“ 151.39193147° o

The callout in the Graphics window is highlighted when you
select a relation in the dialog box. The Information icon in
the Existing Relations box displays the sketch status of the
selected sketch entity. Example: Under Defined, Fully

Defined, etc.

e Add Relations. Add relations to the selected entity. Display the
relations which are possible for the selected entity.

e Options. For construction. Convert the selected entity to

construction geometry.

Parameters. Specify any appropriate combination of parameters

to define your arc if the arc is not constrained by relations. The
options are: Center X Coordinate, Center Y Coordinate,

Start X Coordinate, Start Y Coordinate, End X Coordinate,
End Y Coordinate, Radius, and Angle.
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Tutorial: Centerpoint Arc 4-1

Create a Centerpoint Arc sketch.

1. Create a New LJ part. Use the default
ANSI Part template. é
|

2. Right-click Front Plane from the &
FeatureManager. This is your Sketch RO
plane. Click Sketch € from the
Context toolbar. Click the Line 7

Sketch tool. Sketch a horizontal line
through the origin as illustrated.

3. Click Centerpoint Arc ** from the
Consolidated Arc Sketch toolbar. The
Arc icon is displayed on your mouse
pointer. Click a location on the
horizontal line left of the origin. Do
not pick the origin or the endpoint.

4. Click a position to the right and up on
the horizontal line.

5. Drag to set the angle and the radius of the arc. Release the
mouse button to place the arc. View the Arc
PropertyManager and the coordinates.

6. Click OK ¥ from the Arc PropertyManager. Close the

model. FIEIAE
N Arc @
Tangent Arc Sketch Entity v
Arc Type ~
The Tangent Arc Sketch entity § tool provides the ability to o D A
create an arc, which is tangent to a sketch entity. The Tangent 13|
Arc Sketch entity uses the Arc PropertyManager. View the Parameters | Tengent Arc|
Centerpoint Arc Sketch entity section above for additional oy
information on the Arc PropertyManager. G, 000
w1 G 0.00
“¥* You can transition from sketching a line to sketching a G, oo
Tangent Arc, and vice versa without selecting the Arc tool from & Jow
the Sketch toolbar. Example: Create a line. Click the endpoint of
. ) : ; 3 |06
the line. Move your mouse pointer away. The Preview displays i
another line. Move your mouse pointer back to the selected line A 00
endpoint. The Preview displays a tangent arc. Click to place the g

arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.
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Tutorial: Tangent Arc 4-1

Design Intent, Sketching and Sketch Entities

Create a Tangent Arc sketch.
1. Create a New [ part. Use the default ANSI Part template.

2. Right-click Front Plane from the FeatureManager.
3. Click Sketch  from the Context toolbar.

4. Click the Line 7 Sketch tool.
Sketch a horizontal line through the Origin.

6. Click Tangent Arc =) from the Consolidated Arc Sketch
toolbar. The Arc icon is displayed on the mouse pointer.

7. Click the left end point of the

G EB o]
7

% Part8 (Default<<Default>_D
History
Sensors

4 Design Binder

4 Annotations
Equations
O_ Mat| #— ®:@J>

ﬁ] Fror
m TopF4 Sketch rront Plane)

7 rig B, 3D Sketch On PI;

I—> Orig Section View

horizontal line.

8. Drag the mouse pointer upward §

and to the left for the desired

shape. T -
9. Click an end point. You created a ‘R HE

Tangent Arc. The Arc
PropertyManager is displayed.

10. Right-click Select in the Graphics window to deselect the
Sketch tool. Click OK ¥ from the Arc PropertyManager.

11. Exit the sketch. Close the model.

w1

“¥* You can select an end point of a line, ellipse, arc or a spline. The Tangent Arc tool

creates both Normal and Tangent Arcs.

3 Point Arc Sketch Entity

The 3 Point Arc Sketch entity & tool provides the ability to
create an arc by specifying three points: a starting point, an
endpoint, and a midpoint. View the Centerpoint Arc Sketch entity
section for additional information on the Arc PropertyManager.

Tutorial: 3 Point Arc 4-1

Create a 3Point Arc sketch.
1. Open 3 Point Arc 4-1 from the
SOLIDWORKS 2020 folder.

G

ER[¢[@T

v

N Arc ®@

Arc Type =

2

OS

P!

2. Edit Sketchl. Click 3 Point Are * from 5757 35
the Consolidated Arc Sketch toolbar. ,

N Tangent Arc
£7y 3 Point Arc

Parameters

3 Point Arq

0.00
0.00
0.00
0.00

0.00 ]

0.00
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3. Click the top point of the vertical line for the start point as
illustrated.

4. Click the right point of the open circle for the end point as
illustrated.

5. Drag the arc downward to set the radius.

6. Click a position for the midpoint of the

3Point Arec. -
7. Click OK ¥ from the Arc /X

PropertyManager. e
8. Close the model. u = _

"
Ellipse Sketch Entity =
= [
The Ellipse Sketch entity } tool provides the ability to create a S ERG@T
complete ellipse. The Ellipse PropertyManager controls the © Ellipse @
properties of a sketched Ellipse or a Partial Ellipse. The Ellipse i
PropertyManager provides the following selections: Existing Relations ~
h

o Existing Relations. The Existing Relations box provides the
following option:

@®  Under Defined
e Relations. Display the automatic relations inferenced

during sketching or created manually with the Add R‘f'““’“* ~
Relations tool. The callout in the Graphics window is Fix
highlighted when you select a relation in the dialog box. Options -~

D For construction

The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity. Parameters ~

Example: Under Defined, Fully Defined, etc. G

7.49902659

e Add Relations. Add relations to the selected entity. Display
the relations which are possible for the selected entity. f; LI
4.85985584

<> <> <> <>

e Options. The Options box provides the following option:

e For construction. Convert the selected entity to
construction geometry.

e Parameters. Specify any appropriate combination of parameters to define the ellipse
if the ellipse is not constrained by relations. The available options are: Center X
Coordinate, Center Y Coordinate, Start X Coordinate (only available for a Partial
Ellipse), Start Y Coordinate (only available for a Partial Ellipse), End X
Coordinate (only available for a Partial Ellipse), End Y Coordinate (only available
for a Partial Ellipse), Radius 1, Radius 2, and Angle (only available for a Partial
Ellipse).
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Tutorial: Ellipse 4-1
Create an Ellipse sketch.

1. Create a New | part. Use the A O
default ANSI Part template. < FR‘A Convert
2. Right-click Front Plane from the ::jﬂhpse
FeatureManager. This is your \J Parabola
Sketch plane. N\ Conic

3. Click Sketch C_ from the Context
toolbar.

4. Click the Ellipse & Sketch tool. The Ellipse icon
is displayed on the mouse pointer.

5. Click the origin in the Graphics window. This is
the start location.

6. Drag and click to set the major axis of the
ellipse. The ellipse PropertyManager is displayed.

7. Drag and click again to set the minor axis of the
ellipse.

Deselect the sketch tool.
8. Right-click Select in the Graphics window.

Add a vertical geometric relation in the sketch.
9. Hold the Ctrl key down.

10. Click the top vertical point and the bottom
vertical point of the Ellipse.

11. Right-click Make Vertical from the Pop-up
menu.

12. View the sketch.
13. Close the model.

Partial Ellipse Sketch Entity

The Partial Ellipse Sketch entity } tool provides the ability
to create a partial ellipse or an elliptical arc from a
centerpoint, a start point, and an end point. You used a
similar procedure when you created a Centerpoint Arc. The
Ellipse PropertyManager controls the properties of a
sketched Ellipse or a Partial Ellipse. View the Ellipse
section for additional information on the Ellipse
PropertyManager.
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Parabola Sketch Entity SER[C@T
\_J Parabola @
The Parabola Sketch entity §’ tool provides the ability to create a | .
parabolic curve. The Parabola Sketch entity uses the Parabola e ~
PropertyManager. The Parabola PropertyManager provides the L
following selections:
o Existing Relations. The Existing Relations box provides the ®  Under Defined
following option: Add Relations ~
e Relations. Display the automatic relations inferenced F"X
during sketching or created manually with the Add Options 7
Relations tool. The callout in the Graphics window is [ For construction
highlighted when you select a relation in the dialog box. e ~
The Information icon in the Existing Relations box x| B160657882 .
displays the sketch status of the selected sketch entity. [y | 2725256003 §
Example: Under Defined, Fully Defined, etc. I 0
e Add Relations. Add relations to the selected entity. Display i ;
the relations which are possible for the selected entity. x :
e Options. For construction. Not selected by default. Convert | ‘
the selected entity to construction geometry. I 0
e Parameters. Specify the appropriate combination of = v
parameters to define the parabola if the parabola is not
constrained by relations. The available options are: Start X
Coordinate, Start Y Coordinate, End X Coordinate, End
Y Coordinate, Center X Coordinate, Center Y
Coordinate, Apex X Coordinate, and Apex Y Coordinate.
Tutorial: Parabola 4-1
Create a Parabola sketch. V- @ 0
C
1. Create a New | ] part. Use the default ANSI, IPS 0, m o
Part template. (=) Ellipse
2. Right-click Front Plane from the FeatureManager. \c et ElTEs
This is your Sketch plane. \J Parabola
3. Click Sketch _ from the Context toolbar. [\ Conic

Apply the Parabola Sketch tool.

4. Click the Parabola \J Sketch tool from the
Consolidated Sketch toolbar. The Parabola icon is
displayed on the mouse pointer.
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5. Click a position in the Graphics window to locate
the focus of your parabola.

6. Drag to enlarge the parabola. The parabola is

outlined.

7. Click on the parabola and drag to define the & / L
extent of the curve. The Parabola PropertyManager '
is displayed.

8. Click OK ¥ from the Parabola PropertyManager.
9. Close the model.

Conic Sketch Entity I |

The Conic Sketch entity % tool provides | ¥ v

the ability to sketch conic curves driven Options ~
by endpoints and Rho value. Depending B 5er e i -
on the Rho value, the curve can be
elliptical, parabolic, or hyperbolic. In previous versions of the

Existing Relations ~

|:| Auto tangency

@®  Under Defined

SOLIDWORKS software, you could sketch ellipses and Add Relations ~

parabolas. However, you could not sketch ellipses or parabolas by [ ix

their endpoints, so it was difficult to make them tangent to Options ~

existing geometry. [ For construction
Parameters N

Conic curves can reference existing sketch or model geometry, or
they can be standalone entities. You can dimension the curve with a driving dimension,
and the resulting dimension displays the Rho value. The conic entity also includes a value
for the radius of curvature.

£0.32
po.32

Conic curve sketch that references existing geometry Preview of revolved sketch

Finished model
|

“¥ Auto Tangency accelerates the process of sketching a conic curve.

When you select this option in the Conic PropertyManager, you set the first and second
endpoints for the conic curve. The Conic tool applies tangent relations at each endpoint
of the curve and selects the top vertex of the curve. This option is helpful when you
reference existing geometry. If you clear this option, you must define the top vertex of

the curve.
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The Conic Sketch entity uses the Conic PropertyManager. The @ Blele™
Conic PropertyManager provides the following selections: 1\ Conic @
o Existing Relations. The Existing Relations box provides the |+«

fOHOWing Option: Existing Relations ~

e Relations. Display the automatic relations inferenced b
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.

@ Under Defined

The Information icon in the Existing Relations box R:i:(ations "
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc. °'“i°l“__’|F " ~
e Add Relations. Add relations to the selected entity. Display Parameters ~
the relations which are possible for the selected entity. [ [ 6227850128 s
e Options. The Options box provides the following selection: {5 | 226799828 :
e For construction. Not selected by default. Convert the i v
- - Qe
selected entity to construction geometry. v
. e combinat S
o Parameters. Specify the appropriate combination of X
parameters to define the parabola if the parabola is not s v
constrained by relations. The options are: Start X x :
Coordinate, Start Y Coordinate, End X Coordinate, End A °
Y Coordinate, Center X Coordinate, Center Y p .
Coordinate, Apex X Coordinate, and Apex Y Coordinate. ”
< :
Tutorial: Conic 4-1 —
- AR Vg
Create a Conic sketch. m R
1. Open Conic 4-1 from the o < -
SOLIDWORKS 2020 folder. The model b
. . { C: Partial Ellipse
contains an arc and spline. ~J U purabo
Apply the Conic Sketch tool. Conic
2. Click the Conic "V Sketch tool from the
Consolidated Sketch toolbar. The Conic
icon is displayed on the mouse pointer. & \
. . . ,__-r--'-‘_'___-——_—__——_'—‘_‘-*——,_.e .
3. Click the first endpoint for the conic m
. Vs
curve as illustrated. :
Origin

/
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4. Drag the pointer to the right so it’s tangent
with the arc. Because the endpoint is attached W}_Fr_.——!—_._i_‘
to the existing arc sketch, a yellow inferencing BN
line is displayed.

5. Click the second endpoint as illustrated.

inferencing line is displayed tangent to the L

6. Drag the mouse pointer upwards. A yellow l
spline sketch.

7. Drag the mouse pointer out to the intersection
of the two yellow inferencing lines. You can
snap to the intersection of both inference lines
to choose the top vertex of the conic curve.

8. Click at the intersection of both inferencing — = —— N
lines to set the top vertex of the conic curve. A
By selecting the intersection of both
inferencing lines, you ensure that the conic
curve is tangent at both endpoints.

9. Drag the pointer to the left until the Rho l
value is 0.75. As you move the pointer, the
conic curve's Rho value changes.

10. Click to set the Rho value to 0.75. Reference
points are displayed for the curve's shoulder
and top vertex. Tangent relations are created
between the curve and the original sketches.

11. Click OK ¥ from the Conic
PropertyManager.

12. Close the model.

Conic surfaces are very useful for precision
flowing (aerodynamic) shapes. It is best to have
no more than one singular point on a surface. The
midline curve is usually shared by the top and
bottom fuselage shape surfaces.

Rho is the squareness for conic, and translates into
the squareness of the surface. In theory at 1.0 it is

a dead sharp corner, 0.8 is a very modern squarish
corner, 0.6 is most useful for airplane fuselages, 0.4
looks like an ellipse, and 0.1 is a slanted ellipse
section that tends toward a line between the end
points.
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Spline Sketch Entity S ERGC T
. . » . [ U spline @
The Spline Sketch entity V" tool provides the ability to create a y
profile that utilizes a complex curve. This complex curve is
called a Spline, (Non-uniform Rational B-Spline or NURB). Existing Relations ‘=
b

Create a spline with control points. With spline control points,
you can:

@  Under Defined

e Use spline points as handles to pull the spline into the shape A Retations |

you want.
Qf Fix
e Add dimensions between spline points or between spline u— ;i
points and other entities. [ For construction
|:| Show curvature

e Add relations to spline points. o
M Maintain internal

continuity

The 2D Spline PropertyManager provides the following
selections: Parameters

Moo

e Existing Relations. The Existing Relations box provides the
u

following option:
g

0.00

<€ > < » < 2>

e Relations. Display the automatic relations inferenced
during sketching or created manually with the Add

el

Relations tool. The callout in the Graphics window is a
highlighted when you select a relation in the dialog box. A 36788291°

The Information icon in the Existing Relations box [Jangent driving
displays the sketch status of the selected sketch entity. S
Example: Under Defined, Fully Defined, etc. v

® Add Relations. Add relations to the selected entity. Display
the relations which are possible for the selected entity.

e Options. The Options box provides the following selections:

e For construction. Not selected by default. Convert the
selected entity to construction geometry.

e Show Curvature. Not selected by default. Control the
Scale and Density of the curvature. Display the
Curvature of the spline in the Graphics window.
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Maintain Internal Continuity. Selected by default. Maintain the spline's internal
curvature. When Maintain Internal Continuity is cleared, the curvature scales
down abruptly.

Raised degree. Available only with splines that include curvature handles at each
end. Raises or lowers the degree of the spline. You can also adjust the degrees by
dragging the handles.

Raised degree

Parameters. Specify the appropriate combination of parameters. The available

parameters are:

Spline Point Number. Highlight your selected spline point in the Graphics
window.

X Coordinate. Specify the x coordinate of your spline point.
Y Coordinate. Specify the y coordinate of your spline point.

Radius of Curvature. Control the radius of curvature at any spline point. This
option is only displayed if you select the Add Curvature Control option from the
Spline toolbar, and add a curvature pointer to the spline.

Curvature. Display the degree of curvature at the point where the curvature
control was added. This option is only displayed if you add a curvature pointer to
the spline.

Tangent Weightingl. Control the left tangency vector by modifying the spline’s
curvature at the spline point.

Tangent Weighting 2. Control the right tangency vector by modifying the
spline’s curvature at the spline point.

Tangent Radial Direction. Control the tangency direction by modifying the
spline’s angle of inclination relative to the X, Y, or Z axis.
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e Tangent Polar Direction. Control the elevation angle of the tangent vector with
respect to a plane placed at a point perpendicular to a spline point. This is only for
the 3D Spline PropertyManager.

e Tangent Driving. Enable spline control by using the Tangent Magnitude option
and the Tangent Radial Direction option.

¢ Reset This Handle. Return the selected spline handle to the initial state.
¢ Reset All Handles. Return the spline handles to their initial state.

e Relax Spline. Sketch your spline and display the control polygon. You can drag
any node on the control polygon to change shape. If the node you are dragging
results in a spline which is not smooth, re-select the spline to display the
PropertyManager. Click the Relax Spline selection under the Parameters option.
This will re-parameterize or smooth the shape of your spline.

e Proportional. Retains the spline shape when you drag the spline.

Spline toolbar Spline Tools
Use the tools located on the Spline toolbar to ?’ *;6 /f_ }.-".I_.“; L_ HE% O\ ﬂ

control properties of a sketched spline. The
Spline toolbar provides the following tools:

s
e Add Tangency Control. The Add Tangency Control tool 7
adds a tangency control handle. Drag the control handle along
the spline and position it to control the tangency at the selected
point.

e Add Curvature Control. The Add Curvature Control tool 0
adds a curvature control handle. Drag the control handle along
the spline and position the control handle to control the spline
shape at the selected point.

e Insert Spline Point. The Insert Spline Point tool r adds a
point to the spline. Drag spline points to reshape the spline.

n s
P

You can insert dimensions between the spline points.

o Simplify Spline. The Simplify Spline tool 7= reduces the
number of points in the spline. This function improves the
performance in the model for complex spline curves.

e Fit Spline. The Fit Spline tool - adds a spline based on the
selected sketch entities and edges.
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e Show Spline Handles. The Show Spline Handles tool el displays all handles of the
selected spline in the Graphic window. Use the spline handles to reshape the spline.

e Show Inflection Points. The Show Inflection Points tool R displays all points where
the concavity of a selected spline changes.

o Show Minimum Radius. The Show Minimum Radius tool /™ displays the
measurement of the smallest radius in the selected spline.

e Show Curvature Combs. The Show Curvature Combs tool

4 displays the scalable curvature combs which visually nJ Tg O
enhance the curves of your selected spline. .
J Spline
Tutorial: 2D Spline 4-1 A/ Style Spline
Create a 2D Spline sketch. @& Spline on Surface
1. Create a New L part. Use the default ANSI, IPS “A Equation Driven Curve

Part template.

2. Right-click Right Plane from the FeatureManager.
This is your Sketch plane.

3. Click Sketch & from the Context toolbar.

Apply the Spline Sketch tool.
4. Click the Spline [V Sketch tool. The spline icon is
displayed on the mouse pointer.

5. Create the Spline. This is an open profile. Create a
seven point control spline as illustrated. Do not
select the origin. The Spline PropertyManager is
displayed.

6. Right-click Select on the last control point. l.
7. Exit the Spline [V tool.

8. Click and drag the spline from left to right. Do not
select a control or handle. The spline moves without
changing its shape. <

9. Click OK ¥ from the Spline PropertyManager.
10. View the results.
11. Close the model.
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AR Spline handles are displayed by default. To hide or display spline handles, click the

Show Spline Handles (e tool from the Spline toolbar or click Tools > Spline Tools >
Show Spline Handles.

Tutorial: 2D Spline 4-2

Dimension a 2D Spline sketch handle.
1. Open 2D Spline 4-2 from the SOLIDWORKS 2020 folder.

2. Edit Sketchl.

Use the Smart Dimension tool to
dimension a spline handle. Display the
handles.

3. Click the Spline in the Graphics
window. The Spline
PropertyManager is displayed.
Locate the pointer on the top

handle. The rotate & icon is
displayed.

4. Click the top handle tip.

5. Rotate the handle upwards as
illustrated to create a Tangent
Driving.

6. Right-click Smart Dimension € from the &
Context toolbar.

Create a Tangent Radial dimension.
7. Click the handle arrow tip.

8. Click the horizontal line.
9. Enter 40deg.

10. Set precision to none.

Modify

\/)()'*ﬂg,

D1 1

Angle
40deg -
N

Units

11. Click OK % from the Dimension
PropertyManager. View the results.

12. Close the model.

1]
w1
“¥" For a Tangent Magnitude, select the arrow Tolerance/Precision ~
tip on the handle to add the dimension. 3, [None v
. : . 01
sl gy [,12 (Document) ']

“¥" Tllustrations may vary depending on
SOLIDWORKS version and system setup.
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Tutorial: 3D Spline 4-1
Create a 3D Spline Sketch.

1. Create a New | part. Use the default ANSI Part

template.
2. Click Insert > 3D Sketch from the Menu bar menu. — L
Apply the Spline Sketch tool. m

3. Click the Spline /V Sketch tool.

4. Click a location in the Graphics window to

place the first spline point. Each time you
click a different location, the space handle
is displayed to help you sketch on a
different plane. N
v ¥~

¥ Press the Tab key to change planes in a
3D Sketch.

5. Click three additional locations as

illustrated. The Spline PropertyManager is

displayed.
6. Right-click Select on the last control point. L
7. Exit the 3D Sketch. 3DSketchl is created /

and displayed in the FeatureManager. First point
8. Close the sketch.

Last point
Tutorial: 3D Spline 4-2
Edit a 3D spline sketch using the current elements.
1. Open 3D Spline 4-2 from the SOLIDWORKS
2020 folder.
2. Edit 3DSketchl.
3. Click the Spline in the Graphics window. The / *

Spline PropertyManager is displayed.

Modify the Spline shape using the click and drag

method on a control point.

4. Click a spline control point as illustrated and
drag it upward. The Point PropertyManager is
displayed. View the results.
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Modify the Spline shape using the x-, y- and

z- coordinates method on a control point.

5. Click a spline point as illustrated. The Point
PropertyManager is displayed.

6. Set values for x-, y-, and z- coordinates from
the Point PropertyManager. You modified the
shape of the spline.

Modify the Spline shape using the click and drag
method on a handle.
7. Click a spline handle as illustrated.

8. Drag the selected spline handle to control the
tangency vector by modifying the spline’s
degree of curvature at the spline point. The
Spline PropertyManager is displayed.

Reset the handle to the original location.

9. Click the Reset This Handle option. All values
relative to the selected handle return to their
original value.

Move the spline.

10. Click and drag the spline from left to right. Do
not select a control point. As the spline is
moved, it retains its shape.

11. Click OK ¢ from the Spline
PropertyManager.

12. Exit the 3D Sketch. View the results.
13. Close the model.

Tutorial: 3D Spline 4-3

Add new elements to a 3D Spline.
1. Open 3D Spline 4-3 from the
SOLIDWORKS 2020 folder.

2. Edit 3DSketchl.

3. Click the spline from the Graphics
window. The Spline PropertyManager is
displayed.

SOLIDWORKS® 2020 Reference Guide

Parameters

o, 400 i
s, 3000 i
s, 500] i

%_,
L

[#] Tangent Driving

Reset This Handle
Reset All Handles

Relax Spline

Proportional

4. Click the Add Tangency Control 7 tool
from the Spline toolbar.

Spline Tools

vior LB A o
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5. Drag to place the handle as illustrated.
6. Click a position for the handle.

7. Click OK ¥ from the Spline

PropertyManager.
8. Exit the 3D Sketch. View the results.
9. Close the model. L
=
Style Spline

The Style Spline >‘ tool provides the ability

to sketch single-span Bézier curves. These curves
let you create smooth and robust surfaces and are
available in 2D and 3D sketches.

The Style Spline consists of only one span. You
shape its curvature by selecting and dragging
control vertex points. Sketch entities connect the
control vertices which form the control polygon
of the curve.

With the Style Spline tool, you can control the degree and
continuity of the curves. You can inference style splines
for tangency or equal curvature. You can constrain the
points and dimension the curves' sides. These curves also
support mirroring and self-symmetry.

Spline on Surface Entity

The Spline on Surface entity @ tool provides the
ability to sketch splines on various surfaces.
Splines sketched on surfaces include standard
spline attributes, as well as the capabilities to add
and drag points along the surface and to generate a
preview that is automatically smoothed through the
points.

i

Al spline points are bounded to the surface on
which they are sketched.
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Tutorial: Spline on Surface 4-1

Create a Closed Spline on Surface feature. g {UE e

1. Open Spline on Surface 4-1 from the e "Sline on surface
SOLIDWORKS 2020 folder. n ETTIITE

2. Click the top left face as illustrated.

- -

3. Click the Spline on Surface © Sketch tool. The
spline icon is displayed on the mouse pointer.

4. Create a five point closed spline as illustrated.

5. Click OK ¥ from Spline PropertyManager to
close the sketch tool.

6. Click the Extruded Boss/Base Features tool. The
Boss-Extrude PropertyManager is displayed.

7. Click the left vertical line as illustrated for
Direction 1. Edge<1> is displayed in the
Direction of Extrusion box.

8. Enter 10mm for Depth. K|

9. Click OK % from the Boss-Extrude
PropertyManager. Boss-Extrudel is

displayed. Yiew the results in the BEEE
Graphics window. @) Boss-Extrudet @
10. Close the model. : *® N
Splines on surfaces can: (R ]
Direction 1 A
e Span multiple faces. %]
P Edge<1>
e Update if model geometry is updated I
(unless the splines are constrained). & [1000mm =
Mergeresult %“[%‘-@-‘Q‘FF)
e You can move the points on the ®) = i
spline to different faces by dragging peiherE S Spline on Surface 4-1 (Defaut
the points but not by dragging the L pirecton® 7 :"t"ry
curve 1tself - 4 Design Binder
4 Annotations
» [@]Solid Bodies(1)
Equations

O m—
8= Material <not specified>
m Front Plane

Ej Top Plane
m Right Plane

I_. Origin
v ﬂ Extrude-Thin1
C Sketch1
kﬂ Boss-Extrude1

(30 (-) 3DSketch1
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Intelligence Modeling - Equation TERE®

= B

Driven Curve £ Eqution Drven .. 3 % [E$ ° ®

v X v X
The Equation Driven Curve bft tool is @ 2D Sketch | seticeoquatonn | |Messsge ~
spline driven by an equation. This Sketch entity IR U | | i i
provides the ability to create a curve by specifying . | | oputated secording to he st
the equations that define the curve. You can use any Oppiiit Equation Type ~
function that is supported in the Equations dialog e | Sowe
box. See Chapter 18 - Intelligence modeling Equation —— N
techniques for additional information. § Equation
The Equation Driven Curve entity uses the Equation | P:,amete,s
Driven Curve PropertyManager. The . « A
PropertyManager provides the following selections: A -

o Equation Type. Available types: Explicit (selected by default)
and Parametric.

e Explicit. Define X values for the start and endpoints of the
range. Y values are calculated along the range of X values.

e Parametric. Define T values for the start and endpoints of the
range. You can define an equation for X values and another
equation for Y values. Both equations are solved along the range of T values.
Only parametric curves are available in 3D sketches.

o Parameters. The Parameters box provides the following options:

e Equation. Enter an equation as a function of X-. If you enter an equation that
can’t be resolved, the text color is displayed in red.

e Parameters. Enter the start and end X value of the equation.
e Transform. Enter the translation of X-, Y- and angle for the curve.
Tutorial: Equation Driven Curve 4-1

Create an Equation Driven Curve on the Front Plane.
1. Create a New L part. Use the default ANSI, IPS Part template.

Create a 2D Sketch on the Front Plane.
2. Right-click Front Plane from the FeatureManager.

3. Click Sketch E from the Context toolbar. The
Sketch toolbar is displayed. Front Plane is your

Sketch plane. (% 'J ¥ U
4 Cli ] . ﬁ g fU Lé%line
. Click the Equation Driven Curve ** Sketch tool. A/ sty spline
The Equation Driven Curve PropertyManager is \~.% o
displayed. This tool provides the ability to build | Jx Fauation Driven Curve

intelligences into a part.
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Specify the equation that defines the sketch. Note: y- is a function

of x-. GO BER o @
5. Click Explicit for Equation Type. ' Equation Driven C... (2
v X
6. Enter 3*x*sin(x) as illustrated in the Equation Message -
box. n -
Equation Type [a
7. Enter 0 for the start point as illustrated. gEXP"C“
Parametric
8. Enter 4*pi for the end point. Note: You can fix barameters ~
the end points of the curve by applying the Fix 1 e
tOOl. Yx | 3%*sin(x) ‘
9. Click OK ¥ from Equation Driven Curve perameters
PropertyManager. View the created curve. * D
Note: click the curve in the Graphics window to 0 il
edit the Parameters of the curve. H

10. Click Exit Sketch. View the results.
11. Close the model.

w1

“¥* Use regular mathematical notation and order of operations to write an equation. x;
and x» are for the beginning and end of the curve. Use the transform options at the bottom
of the PropertyManager to move the entire curve in X-, y- or rotation. To specify x=f(y)
instead of y = f(x), use a 90-degree transform.

w 1

‘¥ View the .mp4 provided movies in the book to better understand the potential of the
Equation Driven Curve tool. The first one is Calculating Area of a region bounded by
two curves (secx)”2 and sin x in SOLIDWORKS; the second one is Determine the
Volume of a Function Revolved Around the

x Axis in SOLIDWORKS. Both are located

in the SOLIDWORKS 2020 folder.

Curve Through XYZ Points

The Curve Through XYZ Points & feature
provides the ability to either type in (using | Curve File X
the Curve File dialog box) or click Browse ‘
and import a text file using x-, y-, z-

. . Point X Y| Z
coordinates for points on a curve. Save

Browse...

A text file can be generated by any Save As
program which creates columns of

Insert

numbers. The Curve [2) feature reacts like
a default spline that is fully defined. oK

Cancel
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Create a curve using the Curve Through XYZ Points tool. Import the x-, y-, z- data.
Verify that the first and last points in the curve file are the same for a closed profile.

w1

“¥" Tt is highly recommended that you insert a few extra points on either end of the
curve to set end conditions or tangency in the Curve File dialog box.

Imported files can have an extension of either *.sldcrv or *.text.
The imported data: x-, y-, z-, must be separated by a space, a comma, or a tab.

Tutorial: Curve Through XYZ points 4-1

Create a curve using the Curve Through XYZ Points tool. Import x-
, Y-, z- data from a CAM program. Verify that the first and last

points in the curve file are the same for a closed profile. V| @
1. Open Curve Through XYZ points 4-1 from the Curves| instant3D
SOLIDWORKS 2020 folder.
i%Curve Through XYZ Points
2. Click the Curve Through XYZ Points Y tool (S Helix and Spiral
from the Features CommandManager. The Curve
File dialog box is displayed. [ curves ¢+ sldcrnv) ~|

‘ - Curves (*sld
Import x-, y-, z- data. Verify that the first and last points Mmes ooy I

in the curve file are the same for a closed profile.
3. Click Browse from the Curve File dialog box.

4. Browse to the SOLIDWORKS 2020 folder. TopDownAssemblyModeling
5. Set file type to Text Files. Virtual Components
6. Double-click cam?2.text. View the data in the . - cam2

Curve File dialog box. View the sketch in the
Graphics window. Review the data
points in the dialog box.

Curve File X

‘ D:\2020 SOLIDWORKS Reference Guide\SOLIDWOR | growea

7. Click OK from the Curve File dialog "
. . . Point X Y|
box. Curvel is displayed in the 1 50mm omm omi save
FeatureManager. This curve can now be 2 | 4999mm|  0.88mm Ll
. 3 49.97mm 1.78mm omi S A
used in a sketch (fully defined profile). o 2003mm 2.68mm o e
View the results of the fully defined 5 | 4988mm  3.61mm omi _—
SketCh USin the curve 6 49.82mm 4.54mm omi
g * 7 49.75mm 5.49mm Oomi
OK
8 49.66mm 6.44mm omi
8. Close the model. o | 2056mm| 741mm o
. 10 49.46mm 8.39mm Oomi Cancel
9. Open Curve Through XYZ points 4-2 S T Y Y T — e ¥

from the SOLIDWORKS 2020 folder to
view the final model and
FeatureManager.

10. Close the model.
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Curve Through Reference Points e
The Curve Through Reference Points  tool provides the .
ability to create a curve through points located on one or

more planes. See SOLIDWORKS Help for additional %sput Line
information. Nyl Project Curve

l/_\'] Composite Curve

U Curve Through XYZ Points

© curve Through Reference Point;
[‘8 Helix and Spiral

Point Sketch Entity SEPE b

The Point Sketch entity tool provides the ability to insert = Point ®@
points in your sketches and drawings. To modify the

properties of a point, select the point in an active sketch, v
and edit the properties in the Point PropertyManager. The Existing Relations S
Point PropertyManager provides the following selections: L

e Existing Relations. The Existing Relations box
provides the following option:

@ Under Defined

e Relations. Display the automatic relations
inferenced during sketching or created manually Add Relations ~
with the Add Relations tool. The callout in the X | Fix
Graphics window is highlighted when you select a
relation in the dialog box. The Information icon in
the Existing Relations box displays the sketch status *x
of the selected sketch entity.

Control Vertex Parameters ~

-172.43773585

e, |4745660377

£ > < >

e Add Relations. Add relations to the selected entity.
Display the relations which are possible for the selected
entity.
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e Parameters. Specify the appropriate combination of parameters for your point only if
the point is not constrained by relations. The available parameters are:

e X Coordinate. Specify the x coordinate of your point.

¢ Y Coordinate. Specify the y coordinate of your point.

Centerline Sketch Entity

The Centerline Sketch entity > tool provides the ability to use
centerlines to create symmetrical sketch elements and revolved
features, or as construction geometry. The Centerline sketch
entity uses the Insert Line PropertyManager. The Insert Line
PropertyManager provides the following selections:

e Orientation. The Orientation box provides the following
options:

e As sketched. Sketch a line in any direction using the
click and drag method. Using the click-click method, the
As sketched option provides the ability to sketch a line in
any direction, and to continue sketching other lines in
any direction, until you double-click to end your process.

e Horizontal. Sketch a horizontal line until you release
your mouse pointer.

e Vertical. Sketch a vertical line until you release your
mouse pointer.

= [EEN
© ERo@T
/" Insert Line @
v X
Message N
Edit the settings of the next new
line or sketch a new line.
Orientation >
@ As sketched
O Horizontal
O Vertical
O Angle
Options ~

|:| For construction
[ infinite length
O Midpoint line

e Angle. Sketch a line at an angle until you release your mouse pointer.

s
i

The angle is created relative to the horizontal.

e Options. Line types are:

¢ For construction. Selected by default. Convert the selected sketch entity to

construction geometry.

¢ Infinite length. Not selected by default. Create a line of infinite length which you

can later trim in the design process.

e Midpoint line. Create a line that is symmetrical from the midpoint of the line.

w1

“¥" Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.
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Text Sketch Entity S ERle@T
A\ Sketch Text @
The Text Sketch A entity tool provides the ability to sketch text |, x

on the face of a part and extrude or cut the text. Text can be

. . .. Curves ”~
inserted on any set of continuous curves or edges. This includes %

circles or profiles which consist of lines, arcs or splines.

3 L Text ~

“¥" Convert the sketch entities to construction geometry if the
curve is a sketch entity, or a set of sketch entities, and your
sketch text is in the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager.
The Sketch Text PropertyManager provides the following
selections:

e Curves. The Curves box provides the following options:

0
< H
E il H
®] Q)

>

e Select Edges, Curves Segment. Display the selected
curves, edges, sketches, or sketch segments. A [ 100%

100%

>
Fm

e Text. The options are:

Use document font

e Text. Display the entered text along the selected entity in
the Graphics window. If you do not select an entity, the ot
text is displayed horizontally starting at the origin.

e Bold Style. Bold the selected text.

e Italic Style. Italicize the selected text.
e Rotate Style. Rotate the selected text.

o Left Alignment. Justify text to the left. Only available for text along an edge,
curve or sketch segment.

e Center Alignment. Justify text to the center. Only available for text along an
edge, curve or sketch segment.

e Right Alignment. Justify text to the right. Only available for text along an edge,
curve or sketch segment.

e Full Justify Alignment. Justify text. Only available for text along an edge, curve
or sketch segment.

e Flip. Flip the text.

e Flip Vertical direction and back. The Flip Vertical option is only available for
text along an edge, curve or sketch segment.
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e Flip Horizontal direction and back. The Flip Horizontal option is only available

for text along an edge, curve or sketch segment.

e Width Factor. Widen each of your characters evenly by a specified percentage.
Not available when you select the Use document's font option.

e Spacing. Modify the spacing between each character by a specified percentage.

Not available when your text is fully justified or when you select the Use

document's font option.

e Use document's font. Selected by default. Clear the initial font and to choose

another font by using the Font option button.

e Font. Choose a font size and style from the Font dialog box.

Tutorial: Text 4-1

Apply text on a curved part. Use the Sketch Text tool.

1. Open Text 4-1 from the SOLIDWORKS 2020
folder. The Lens Cap is displayed in the Graphics
window.

2. Click Front Plane from the FeatureManager.
Apply the Text Sketch tool.

3. Click the Text A Sketch tool. The Sketch Text
PropertyManager is displayed.

4. Click inside the Text box.

5. Type SOLIDWORKS. SOLIDWORKS is
displayed horizontally in the Graphics window
starting at the origin, because you do not select an
entity.

6. Click inside the Curves option box.

7. Click the front edge of Base Extrude. Edge<1>
is displayed in the Curves option box. The
SOLIDWORKS text is displayed on the selected
edge.

8. Uncheck the Use document font box.
9. Enter 250% in the Spacing box.

10. Click the Font Button. The Choose Font dialog
box is displayed.

11. Select Arial Black, Regular, Point 14.
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12. Click OK from the Choose Font dialog box.

13. Click OK ¥ from the Sketch Text PropertyManager. Sketch7
is created and is displayed in the FeatureManager. Zoom in on
the created text.

14. Close the model.

L
“¥* If the curve is a sketch entity, or a set of sketch entities, and
the sketch text is in the same sketch as the curve, convert the

sketch entities to construction geometry.

SOLIDWORKS® 2020 Reference Guide

Plane Sketch Entity

The Plane Sketch entity tool provides the ability for the user to
add Reference entities to a 3D sketch. Why? To facilitate
sketching, and to add relations between sketch entities. Once
you add the plane, you need to activate it to display its
properties and to create a sketch. The Plane sketch entity uses
the Sketch Plane PropertyManager.

The Sketch Plane PropertyManager provides the following
selections:

o First Reference. Select Reference entities from the

FeatureManager or from the Graphics window. Select the
constraining relations to each reference. The available
relations selection is based on the selected geometry.

Reference Entities. Display the selected sketch entity
or plane as the reference to position the 3D Sketch

SRR S S

{1 Sketch Plane @
v X ;

Message

Select references (planes, sketch
entities, edges, faces or vertices) to
define the sketch plane. Then select
the constraining relations to each
reference.

First Reference

i

Second

i

Third Reference

i

Reference

plane.

Select a relation. Select a relation based on the selected
geometry.

w s

“¥* The available relations are displayed in the Sketch Plane
PropertyManager under the First, Second and Third Reference.
The relations are based on existing geometry.
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Second Reference. Select Reference entities from the FeatureManager or from the
Graphics window. Select the constraining relations to each reference. The available
relations selection is based on the selected geometry.

¢ Reference Entities. Display the selected sketch entity or plane as the reference to
position the 3D Sketch plane.

e Select a relation. Select a relation based on the selected geometry.

Third Reference. Select Reference entities from the
FeatureManager or from the Graphics window. Select the
constraining relations to each reference. The available
relations selection is based on the selected geometry.

e Reference Entities. Display the selected sketch entity
or plane as the reference to position the 3D Sketch
plane.

e Select a relation. Select a relation based on the
selected geometry.

w1

-~

" With existing geometry, add a plane by referencing the

entities that are present. Use any number of references
required to achieve the desired results.

Tutorial: Sketch Plane 4-1

, = D
Add a 3D Sketch plane. Add a plane using references. Select $ Bl
two corner points of a 3D sketch. The corner points of the
.- @5 Sketch Plane 4-1 (Default< <Def
rectangle reference the position of the 3D sketch plane. it
1. Open Sketch Plane 4-1 from the SOLIDWORKS 2020 Sens:;
folder. 4 Design Binder
2. Edit 3DSketchl from the FeatureManager. + [A] Annotations
s .
Click Tools > Sketch Entities > Plane. The Sketch Ej;:tr':rinots ecifieds
Plane PropertyManager is displayed. Oﬂ? Eront Plane P
hrLrd Ej Top Plane
“¥* Rename a feature or sketch for clarity. Slowly click the (] Right| G218
feature or sketch name twice and enter the new name when origir = 42 1
the old one is highlighted. é‘ S Dske
Feature (3DSketch1)
Comment
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4. Click the top front corner point of the rectangle
as illustrated. Point3 is displayed in the First
Reference box.

5. Click the bottom back corner point of the
rectangle. Point4 is displayed in the Second
Reference box. Click OK ¥ from the Sketch
Plane PropertyManager.

6. Close the model.

Route Line Sketch
Entity - o Y ER SR

I

The Route Ling Sketch entity tool sy @' Route Line @
provides the ability to insert a Adds a route lne that connects
. . entities In an explode line sketch or a *
Route line between faces, circular Doern ' v X
edges, straight edges, or planar faces. The Route Line Items To Connect A
Sketch entity is active when you: \s!
e Create an Explode Line Sketch.
. . Oopti ~
e Edit an Explode Line Sketch. prom
|:| Reverse
e Select the Route Line tool in a 3D sketch. Alternate Path
Along XYZ

The Exploded Line Sketch tool @ is a 3D sketch added
to an Exploded View in an assembly. The explode lines
indicate the relationship between components in the assembly.

The Route Line Sketch entity @” uses the Route Line PropertyManager. The Route Line
PropertyManager provides the following selections:

e Items To Connect. The Items To Connect option:

e Reference entities. Display the selected circular edges, faces, straight edges or
planar faces to connect with your created route line.

e Options. The options are:

e Reverse. Reverse the direction of your route line. A preview arrow is displayed in
the direction of the route line.

e Alternate Path. Display an alternate possible path for the route line.
e Along XYZ. Create a path parallel to the X, Y and Z axis directions.

L
s

* Clear the Along XYZ option to use the shortest route.
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Tutorial: Route Line 4-1

Create an Explode Line sketch using the Route Line
Sketch entity.

1.

Open the Route Line 4-1 assembly from the
SOLIDWORKS 2020 folder. The assembly is
displayed in an Exploded view.

Click the Explode Line Sketch s° tool from
the Assembly toolbar. The Route Line
PropertyManager is displayed.

Click the inside face of Cut-Extrudel of Shaft-
Collar<1>. The direction arrow points towards
the back. If required, check the Reverse
direction box. Face<1> @Shaft-Collar-1 is
displayed in the Items To Connect box.

Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<1> component.
Face<2>@Flatbar-1 is displayed in the Items
To Connect box. The arrow points towards the
right.

Click the inside face of Cut-Extrude5 of
RodClevis<1>. Face<3>@AirCylinder-1 is
displayed in the Items To Connect box. The
arrow points towards the back.

Click the inside face of the second Cut-
Extrude5 feature of RodClevis<1>. Face<4>@
AirCylinder-1 is displayed in the Items To
Connect box.

Click the inside face of the top hole of Cut-
Extrudel of the Flatbar<2> component.
Face<2>@pFlatbar-2 is displayed in the Items
To Connect box. The arrow points towards the
back.
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Cut-Extrude1 of Shaft-Collar<1>

” r\\ Cut-Extrt
)

Cut-Extrude5
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8. Click the inside face of Cut-
Extrudel of SHAFT-COLLAR<2>.
The direction arrow points towards
the back. Face<1> (@Shatft-
Collar<2> is displayed in the Items
To Connect box.

9. Click OK ¥ from the Route Line
PropertyManager. View the created
Route Line.

10. Click OK ¢ from the
PropertyManager to return to the
FeatureManager.

Fit the model to the Graphics window.
Display an Isometric view.

11. Press the f key to fit the model to the Graphics window.

12. Click Isometric view. View the results.
13. Close the model.

w1
ELT N

additional information.

w1

4" Inan exploded view assembly, create explode
route lines automatically for selected components by
using the Inset/Edit Smart Explode Lines command.

Tutorial: Route Line 4-2

Edit an Explode Line Sketch.

1. Open Route Line 4-2 from the SOLIDWORKS
2020 folder. The Route Line 4-2 Assembly
FeatureManager is displayed.

2. Click the ConfigurationManager tab.
3. Expand Default.

4. Right-click ExplViewl from the
ConfigurationManager.

5. Click Explode. View the results in the Graphics
window.

6. Expand ExplViewl.
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Tables folder of the FeatureManager. See the Assembly section for
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&

Cut-Extrude1 of S

@;" Route Line @

- <M

Items To Connect A

@ Face <1>@Shaft-Collar-1
Face <2>@°Flatbar-1
Face <3>@AirCylinder-1/RodCl¢
Face <4>@AirCylinder-1/RodCl¢
Face <2>@Flatbar-2

Face <1>@Shaft-Collar-2

[5)

Options A
D Reverse
Alternate Path
Along XYZ

=8 @ %

i "xploded View
%—ﬂ? Explode Line Sketch
%@ Insert/Edit Smart Explode Lines

Update Take Large|
Speedpak Snapshot Assemb
Setting|

SN

Gl

RS @R

\ - @ Route Line 4-2 Configuration(s)
T8  Default [ Route Line 4-2 ]

‘@QExp“

Configurations

Explode

Animiale explode
X Delete

Comment
) Edit Feature
&2 smart Explode Lines.,

25
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Edit the Explode Line Sketch.
7. Right-click 3DExplodel from the
ConfigurationManager.

8. Click Edit Sketch.
9. Display a Top view.
10. Click Centerline - from the Sketch

toolbar. The Insert Line PropertyManager is
displayed.

11. Click the endpoints of the Route Line as
illustrated.

Create a new path.
12. Click a point to the right of the Route Line
endpoint and over the top of the axle.

13. Click a point below the axle as illustrated.

Design Intent, Sketching and Sketch Entities

==

o - L

14. Click a point to the left of the axle over the Flatbar.

15. Click a point below the Flatbar.
16. Click a point above the SHAFT-COLLAR.
17. Click a point below the Shaft-Collar.

Deselect the active Sketch tool.
18. Right-click Select in the Graphics window.

19. View the results.

20. Return to the FeatureManager design tree.
21. Close the model.

w 1

“¥" In an exploded view assembly,
create explode route lines
automatically for selected
components by using the Inset/Edit
Smart Explode Lines command.
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Belt/Chain Sketch Entity

This option provides the ability to create layout sketches for
pulleys or sprocket mechanisms. The Belt/Chain feature
simulates a cable-pulley mechanism. The Belt/Chain entity uses
the Belt/Chain PropertyManager.

AR In the past, it was difficult using SOLIDWORKS to
effectively model components such as cables, chains, and timing
belts due to their flexible motion. The shapes of these items
could change over time. This made it difficult to examine the
way a belt would interact with two or more pulleys, or a cable
system shifts a lever, or crank with a solid assembly model.

The Belt/Chain PropertyManager provides the following
selections:

Belt Members. The Belt Members options are:

e Pulley Components. Display the selected arcs or

circles for the pulley components.

Up arrow. Move the selected pulley component
upwards in the displayed order.

Down arrow. Move the selected pulley component
downward in the displayed order.

Flip belt side. Change the side on which the belt is
located in the pulley system.

Properties. Define the following belt conditions. The
options are:

e Driving. Cleared by default. Calculate the length of
your belt. When checked, enter a value if you do not
want the system to calculate your belt length. Based
on the constraints, one or more of the components

may move to adjust for the length of the belt.

Use belt thickness. Specify the thickness value of the
belt.

Engage belt. Selected by default. Disengage the belt
mechanism.

[

w1
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S ERIS @
Belt/Chain @

v X
Message 2
Select the circle or arc to define belt
members around which the belt will
pass
Belt Members ~
0 Arc1/40MM_Circle-1

Arc1/20MM_Circle-1

Arc1/60MM_Circle-1

Flip belt side

Properties
Belt Length:

Driving

o

Use belt thickness

20.00mm :

Engage belt

~) [ ©

: Only circle entities in a block can be selected for a belt member.
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Blocks S ER [T
. . . o & Make Block

Blocks are a grouping of single or multiple sketch entities. In Il ®
SOLIDWORKS, the origin of the block is aligned to the M
orientation of the sketch entity. Previously, blocks inherited Block Entities A
their origin location from the Parent sketch. Additional Line1
enhancements to Blocks are: stz

Line3
e Modeling pulleys and chain sprockets. Line4

Line5
e Modeling cam mechanisms.
Blocks are used in the Belt/Chain sketch entity. You can Insertion Point -~
create blocks from a single entity or multiple sketch entities.  |[]Layout sketch Block

Drag Manipulator on-screen to

Why should you use Blocks? Blocks enable you to: position insertion point.

Create layout sketches using the minimum of dimensions
and sketch relations.

Freeze a subset of sketch entities in a sketch to control as a single entity.
Manage complicated sketches.

Edit all instances of a block simultaneously.

w1

“¥* Use blocks in drawings to conserve drawing items such as standard label positions,

notes, etc. See SOLIDWORKS Help for additional information.

Blocks toolbar Blocks |

The Blocks toolbar controls blocks in sketching. The @

Blocks toolbar provides the following tools:

Make Block. The Make Block & tool provides the ability to create a new block.

Edit Block. The Edit Block tool provides the ability to add or remove sketch
entities and to modify dimensions and relations in your sketch.

Insert Block. The Insert Block A% tool provides the ability to add a new block to
your sketch or drawing. This option provides the ability to either create multiple
instances of existing blocks or to browse for existing blocks.

Add/Remove. The Add/Remove (e tool provides the ability to add or remove sketch
entities to or from your block.

Rebuild. The Rebuild IE. tool provides the ability to update the parent sketches
affected by your block changes.
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e Saves Block. The Saves Block tool provides the ability to save the block to a file.

Adds an .sldblk extension.

e Explode Block. The Explode Block tool provides the ability to explode the

selected block.

e Belt/Chain. The Belt/Chain @¢ tool provides the ability
to insert a belt.

w1

e Exploding a single instance of the block only affects
that instance of the block.

Tutorial: Block 4-1
Create a Block using the Blocks toolbar.

1. Create a New L) part. Use the default ANSI Part
template.

2. Click Top Plane from the FeatureManager. This is your
Sketch plane.

3. Sketch a closed sketch using sketch entities as
illustrated. The sketch consists of five lines.

i [e]
4. Click Make Block IN from the Block toolbar or click
Tools > Blocks » Make. The Make Block
PropertyManager is displayed.

5. Box-select the sketch entities from the Graphics
window. The selected sketch entities are displayed in the
Block Entities box.

6. Expand the Insertion Point box. Note the location of the
insertion point.

7. Click OK ¥ from the Make Block PropertyManager.
Block1-1 is displayed in the FeatureManager.

8. View the results.
9. Close the model.
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Tt\fl Make Block @
v X
Block Entities >
Line1
Line2
Line3
Lined
Line5
Insertion Point =

|:| Layout Sketch Block
Drag Manipulator on-screen to
position insertion point.

S ElR¢@ .|
¢

% Part7 (Default<<Default>_D|
History

Sensors

Design Binder
Annotations

Equations

§5 Material <not specified>|
Ej Front Plane

Ej Top Plane
Ej Right Plane

I_. Origin

+ [ () Sketch1

v

v

Block1-1
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w1

‘¥* Create a block for a single or combination of multiple
Sketch entities. Saving each block individually provides you
with extensive design flexibility.

Tutorial: Belt-chain 4-1

Use the Belt/Chain Sketch entity function. Create a pulley sketch.

1. Open Belt-chain 4-1 from the SOLIDWORKS 2020 folder.
View the three created blocks in the Belt-chain
FeatureManager.

2. Edit Sketchl from the FeatureManager.

Click Tools » Sketch Entities >
Belt/Chain. The Belt/Chain
PropertyManager is displayed.

4. Select the three circles from left
to right. The select circles are ®
displayed in the Belt Members \A® l‘
dialog box.

Check the Driving box. Q
Enter 460mm for Belt Length. 2
Check the Use belt thickness box.
Enter 20mm for belt thickness.
| | @

Click OK ¥ from the Belt/Chain %= ('a))

PropertyManager.
10. Expand Sketchl. Belt1 is created @
and is displayed in the N
FeatureManager.

o © =N w

11. View the results.
12. Close the model.

w1

A View SOLIDWORKS Help for additional information.

The Select Chain command has been enhanced to allow you to
select construction entities. See SOLIDWORKS Help for
additional information.
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» History

Sensors
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4 Annotations

Equations
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ESIEIEESE ding
Belt/Chain @
v X

Message ~
Select the circle or arc to define belt
members around which the belt will
pass

Belt Members ~

O Arc1/40MM_Circle-1
Arc1/20MM_Circle-1

Flip belt side

Properties A
Belt Length:
Driving

C—
:

Use belt thickness

20.00mm 2
v

Engage belt

EEEE s
v

‘% Belt-chain 4-1 (Default<<Defi
» History

Sensors

Design Binder

Annotations

Equations

§5 Material <not specified>

ﬂ Front Plane

ﬂ Top Plane

ﬂ Right Plane

I_, Origin
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20MM _Circle-1
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Reuse an existing 2D Sketch

You can use the same sketch to create different features. To create different features with
the same sketch:

e (Create a sketch.
e C(Create a feature from the sketch.

¢ In the FeatureManager design tree, select the same sketch used to create the first
feature.

e C(Create a second feature from the sketch.

In the FeatureManager design tree, a sketch that is shared by multiple features is
identified by the Shared &% icon.

w

“¥* Add additional sketches as required to create the features. For example, if one
feature is an extrude and the other feature is a revolve use the same sketch for both
features, but add a centerline to create the revolve.

Tutorial: Shared Sketch 4-1 @ Blol@ T
Create an Extrude Thinl feature with a shared sketch. @) Boss-Extrude ©)
1. Open Shared Sketch 4-1 from the SOLIDWORKS 2020 v X ®
fOldeI‘. From A
2. Click Sketchl from the FeatureManager. View the sketch in . t_Sk Ih g .
the Graphics window.
3. Click Extruded Boss/Base 8 from the Feature toolbar. 4
4. Select Mid Plane for End Condition in Direction 1. (&
Merge result
5. Enter 16.00mm fOT Depth
6. Check the Thin Feature Draft outward

Thin Feature A

&y [4.50mm E

Selected Contours ~

<> Sketch1-Contour<1>

dialog box.

7. Enter 4.50mm for
Thickness.

8. Click the Reverse
Direction button.

9. Click inside the Selected
Contours dialog box.

!
!
[
|

10. Click the circumference of the large circle in the Graphics
window.

11. Click OK ¥ from the PropertyManager.

Page 4 - 66



SOLIDWORKS® 2020 Reference Guide Design Intent, Sketching and Sketch Entities

12. Expand Extrude-Thinl in the
FeatureManager. View the
Shared sketch.

13. Close the model.

v @Boss-ExtrudM
P@,, Sketch1

]} @ Extrude-Thin1

P@,, Sketch1

Summary

In this chapter, you learned about the available tools to incorporate Design Intent into a
sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D Sketching and how to
recognize various Sketch states: Fully Defined, Over Defined, Under Defined, No
Solution Found, and Invalid Solution Found along with identifying the correct Reference
plane.

You reviewed the following Sketch Entities: Line, Corner Rectangle, Center Rectangle,
3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot,
Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle,
Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve, Point,
Centerline, Text, Plane, Route line, and Belt/Chain.

You utilized and addressed the following toolbars: Block toolbar and Spline toolbar and
applied the Instant3D tool.

Fully define all sketches in the model. However, there are times when this is not
practical, generally when using the spline tool to create a freeform shape.

Use Construction geometry to assist in creating your sketch entities and geometry that are
ultimately incorporated into the part. Construction geometry is ignored when the sketch is
used to create a feature. Construction geometry uses the same line style as a centerline.

1 .-

* Press the Tab key to change planes in a 3D Sketch.

L
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You can transition from sketching a line to sketching a Tangent Arc, and vice versa,
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.

Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and
enter the new name when the old one is highlighted.

The plane or face you select for the Base sketch determines the orientation of the part.

w s

“¥" The PropertyManager remembers its last used state.

Chapter 5 provides a comprehensive understanding of the available Sketch tools,
Geometric relations, Dimensions/Relations tools and the DimXpertManager in
SOLIDWORKS.
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